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Preface

About This Manual

This document describes Version 2002.50.00 of both Rational ClearCase configuration
management software and Rational ClearCase MultiSite software for the Windows 98,
Windows Me, Windows NT, and Windows 2000 operating systems.
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Typographical Conventions

This manual uses the following typographical conventions:

ccase-home-dir represents the directory into which the ClearCase Product
Family has been installed. By default, this directory is /usr/atria on UNIX and
C:\Program Files\Rational \ClearCase on Windows.

attache-home-dir represents the directory into which ClearCase Attache has been
installed. By default, this directory is C:\Program Files\Rational \Attache.

Bold is used for names the user can enter; for example, all command names, file
names, and branch names.

Italic is used for variables, document titles, glossary terms, and emphasis.

A monospaced font is used for examples. Where user input needs to be
distinguished from program output, bold is used for user input.

Nonprinting characters are in small caps and appear as follows: <EOF>, <NL>.

Key names and key combinations are capitalized and appear as follows: SHIFT,
CTRL+G.

[ ]Brackets enclose optional items in format and syntax descriptions.

{ }Braces enclose a list from which you must choose an item in format and syntax
descriptions.

| A vertical bar separates items in a list of choices.

...In a syntax description, an ellipsis indicates you can repeat the preceding item or
line one or more times. Otherwise, it can indicate omitted information.

Note: In certain contexts, ClearCase recognizes “...” within a pathname as a
wildcard, similar to “*” or “?”. See the wildcards_ccase reference page for more
information.

If a command or option name has a short form, a “medial dot” ( · ) character
indicates the shortest legal abbreviation. For example:

lsc·heckout

This means that you can truncate the command name to lsc or any of its
intermediate spellings (lsch, lsche, lschec, and so on).
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Online Documentation

The ClearCase graphical interface includes a standard Windows help system.

There are three basic ways to access the online help system: the Help menu, the
Help button, or the F1 key. Help>Help Topics provides access to the complete set of
ClearCase online documentation. For help on a particular context, press F1. Use the
Help button on various dialog boxes to get information specific to that dialog box.

ClearCase also provides access to full “reference pages” (detailed descriptions
of ClearCase commands, utilities, and data structures) with the cleartool man
subcommand. Without any argument, cleartool man displays the cleartool overview
reference page. Specifying a command name as an argument gives information about
using the specified command. For example:

> cleartool man (display the cleartool overview page)

> cleartool man man (display the cleartool man reference page)

> cleartool man checkout(display the cleartool checkout reference page)

ClearCase’s –help command option or help command displays individual
subcommand syntax. Without any argument, cleartool help displays the syntax for all
cleartool commands. help checkout and checkout –help are equivalent.

> cleartool uncheckout –help
Usage: uncheckout | unco [-keep | -rm] [-cact | -cwork ] pname ...

Additionally, the online ClearCase Tutorial provides important information on setting
up a user’s environment, along with a step-by-step tour through ClearCase’s most
important features. To start the ClearCase Tutorial, choose Tutorial in the ClearCase
folder off the Start menu.
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Technical Support

If you have any problems with the software or documentation, please contact
Rational Technical Support via telephone, fax, or electronic mail as described below.
For information regarding support hours, languages spoken, or other support
information, click the Technical Support link on the Rational Web site at www.rational.com.

Your Location Telephone Facsimile Electronic Mail

North America 800-433-5444
toll free or
408-863-4000
Cupertino, CA

408-863-4194
Cupertino, CA
781-676-2460
Lexington, MA

support@rational.com

Europe, Middle
East, and Africa

+31-(0)20-
4546-200
Netherlands

+31-(0)20-
4546-201
Netherlands

support@europe.ratio-
nal.com

Asia Pacific 61-2-9419-0111
Australia

61-2-9419-0123
Australia

support@apac.ratio-
nal.com
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READ ME FIRST 1

This chapter contains important information about Version 2002.05.00 of Rational
ClearCase and Rational ClearCase MultiSite. Read it before you attempt to install
either product. Note that beginning with this release, ClearCase and MultiSite releases
use the same version number and version number format as other Rational Software
products released in the same period.

Note: The term CPF stands for ClearCase Product Family and refers to the products
ClearCase, Attache, and MultiSite. The term 4.x refers to 4.0, 4.1, and 4.2.

ClearCase and MultiSite Hardware and Software Requirements

This section lists the basic platform, hardware, and software requirements for running
ClearCase and MultiSite software.

Supported Architectures

ClearCase and MultiSite Version 2002.05.00 run on the platforms listed in Table 1.

Table 1 Supported Platforms for ClearCase and MultiSite in Version
2002.05.00

Hardware platform Operating system

Intel x86 Windows NT 4.0 SP5 and 4.0 SP6a (but not 4.0SP6)
Windows 2000 SP1 and SP2
Windows 98 all versions (client only)
Windows Me (client only)
Windows XP Professional1

1 Rational ClearCase 2002.05.00 clients support the latest Windows 2000, Windows NT,
Windows Me, Windows XP Professional, and Windows 98 releases. Older releases of Windows,
such as Windows 95 and Windows NT 4.0 SP4, are no longer supported with this release; nor
do we support Windows XP Home. Customers who require support for earlier versions of
Windows should run an earlier version of ClearCase (4.1 or 4.2).

For more information about differences in features and functionality by platform, see
the ClearCase Platform-Specific Guide in online help. To access the platform guide, go
to ClearCase help and click Help Topics.
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Supported Platforms for ClearCase Web Servers

The following platforms support a ClearCase Web server:

Windows 2000

Windows NT 4.0

Windows XP Professional

All supported ClearCase platforms support the ClearCase Web interface. For details
about the Web servers and Web browsers supported on different platforms, see Basic
Software Requirements on page 5.

Supported File Systems

Table 2 lists the file systems that ClearCase supports. If a file system does not appear
on the list, it is not supported. Inform Rational Technical Support or your sales
representative of any concerns you have about this list.

Table 2 Supported File Systems by Platform

Platform Supported file systems

Windows NT FAT, NTFS, LANMAN, NFS1

Windows 98 FAT, FAT32

Windows Me FAT, FAT32, LANMAN

Windows XP
Professional

FAT, FAT32, NTFS, LANMAN

Windows 2000 FAT, FAT32, NTFS, LANMAN

1 See Table 3 for more information on NFS platforms

Windows/UNIX Interoperation

This section provides information about ClearCase support for file access between
Windows and UNIX platforms, as it pertains to Version 2002.05.00. As of this release,
ClearCase supports these Windows/UNIX interoperation solutions:

ClearCase File Server

Third-party NFS client products

Third-party SMB server products

For more information about ClearCase support of these products,
see the Administrator’s Guide. For the most recent information about
ClearCase Windows and UNIX interoperation, see the ClearCase Web site,
www.rational.com/support/products/clearcase.jsp.
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ClearCase File Server (CCFS)

ClearCase clients on Windows NT, Windows 2000, Windows Me, and Windows 98
that use snapshot views can access files in UNIX VOBs using the ClearCase File
Server (CCFS). In addition, UNIX clients using snapshot views can access files in
Windows VOBs using CCFS. If a host uses only snapshot views and is configured to
use CCFS, ClearCase does not require third-party NFS or SMB products to access
UNIX or Windows VOBs.

Note: CCFS does not support dynamic views.

On Windows NT and Windows 2000, CCFS is disabled by default for ClearCase
clients and servers. On Windows 98 and Windows Me, CCFS is enabled by default for
ClearCase clients.

For more information about CCFS, see the Administrator’s Guide for Rational
ClearCase.

Third-Party NFS Client Products

ClearCase hosts on Windows NT can access UNIX VOBs and views using an NFS
client for Windows NT product. To use NFS, you must install one of the products
listed in Table 3 on each ClearCase for Windows NT host from which you want to
access a UNIX VOB or view.

Table 3 Supported NFS Client Products for Windows

Product Supported product versions

Hummingbird NFS Maestro 7.0.0.1 or later

Shaffer Solutions Corporation DiskAccess 5.0 or 5.1

Microsoft Windows NT Services for UNIX
(SFU) Add-On Pack (NFS Client)

Version SFU 1.0 only

Third-Party SMB Server Products

Windows NT hosts can use an SMB server product to access UNIX VOBs and views.
To use SMB, you must install one of the products listed in Table 4 on each UNIX server
host from which you want to access a UNIX VOB or view.
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Table 4 Supported SMB Server Products for Windows NT

Product Platform Supported product versions

Solaris 2.6 or later 5.2 (Patch 10), 5.3 (Patch 3),
5.4.1 patch 3; 6.0, 6.1

HP-UX 11.0 or later 5.4.1 patch 3; 6.0, 6.1

Syntax TotalNET
Advanced Server
(TAS)

AIX 4.3.2 and above TAS 6.0 only

Solaris 8 or later Samba 2.0.7, 2.2

HP-UX 11.0 or later Samba 2.0.7, 2.2

AIX 5.1 Samba 2.2

Samba
(available from
www.samba.org)

Linux RedHat 7.2 Samba 2.2

Contact Rational Technical Supporte for current Windows and UNIX interoperation
partner information.

For more information about Samba or TAS, see the Administrator’s Guide for Rational
ClearCase.

Hardware Requirements

This section describes hardware requirements for installing and running ClearCase
and MultiSite.

Disk Space Requirements for the Release Area

The file system of the networkwide release host must have sufficient disk space to hold
the release area. The minimum disk space required for release areas on different
platforms is shown below:

Windows NT
Windows 2000

140 MB
140 MB

Disk Space Requirements for Individual Hosts

Table 5 shows the approximate disk space requirements for a new installation of
ClearCase. These figures are for ClearCase files and upgraded system files only. In
addition to the requirements below, the installation needs 15 MB of temporary disk
space.
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Table 5 Disk Space Required for ClearCase Files and Upgraded System Files

ClearCase installation type Disk space required

Windows 98 and Windows Me client 95 MB

Windows NT and Windows 2000 client
or server using standard installation
with dynamic views (5 MB for dynamic
views), local VOBs, and local views

120 MB

Windows NT and Windows 2000 client
or server with all optional components

138 MB

In addition, any host that will have snapshot view directories needs enough disk
space to contain all files loaded into the snapshot views and all view-private files
added to the views. The amount of space required depends on the number and sizes
of the files in the views.

Any host that will have VOB- or view-storage directories must have enough disk
space to contain the files and databases used for storage of VOB- or view-storage
directories. The amount of space required depends on the characteristics and use
of the VOBs and views.

Software Requirements

This section describes software requirements for running ClearCase and MultiSite.

Basic Software Requirements

ClearCase requires the following software on Windows NT, and Windows 2000:

Windows Workstation or Windows Server

Internet Explorer (5.0.1 SP2 or later: Internet Explorer does not have to be the
default browser, but is required for use of some ClearCase features, including
the ClearCase Explorer, the HTML Diff Merge tool, the ClearCase Automation
Library (CAL), and the ClearCase Administration Console. The recommended
version is 5.5 SP2.

If acting as a ClearCase Web server: Web server software, either Apache (version
1.3.14 and above), iPlanet Enterprise Server (version 4.1 SP8 through 6.0), or
Microsoft Internet Information Server (IIS 4.0 for Windows NT systems, IIS 5.0 for
Windows 2000 and Windows XP Professional systems). Note that Apache is not
suppored as a ClearCase Web server on Windows XP Professional at this time.
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If acting as a server for the ClearCase integrations with FrontPage 98, FrontPage
2000, Visual InterDev, IIS Web server software and the FrontPage Server Extensions
(FPSE).

An Adobe Acrobat Reader, version 3 or later, to access the online manuals, which
are in PDF format.

On any system accessing ClearCase through the Web interface, a Web browser;
either Netscape (version 4.72 through 4.78) or Internet Explorer (version 5.01 SP2
through 5.5 SP1). Netscape 6 is not supported. (Note that it is not necessary to
install ClearCase on such a system.)

ClearCase requires the following software on Windows 98 and Windows Me:

Client for Microsoft Networks (shipped with Windows 98 and Windows Me)

Internet Explorer 5.0.1 SP2 or later: Internet Explorer does not have to be the
default browser, but is required for use by some ClearCase features, including the
ClearCase Explorer, the HTML Diff Merge tool, and the ClearCase Automation
Library (CAL). The recommended version is 5.5 SP2.

An Adobe Acrobat Reader, release 3 or later, to access the online manuals, which
are in PDF format.

On any system accessing ClearCase through the Web interface, a Web browser;
either Netscape (4.72 through 4.78), or Internet Explorer (5.01 SP2, 5.5, or 6.0).
(Note that it is not necessary to install ClearCase on such a system.)

Although the standard ClearCase interface is not supported on Windows XP Home
systems (and the product cannot be installed on such systems), the Web interface can
be accessed from a Windows XP Home system using Internet Explorer 6.0.

Using ClearCase and Windows NT Server Domains

ClearCase is a distributed client/server application; many operations initiated on
client hosts are completed by server processes elsewhere in the network. Therefore,
all ClearCase hosts running Windows NT or Windows2000 must belong to a
Windows NT Server domain or an Active Directory domain, except as noted in the
Administrator’s Guide for Rational ClearCase. On all Windows 98 hosts, the Client for
Microsoft Networks component in Network properties must be configured to log on
to a Windows NT Server domain or an Active Directory domain.

To use ClearCase from a supported Windows host, you must log on to a domain
account (not a local, per-system user account). For more information about
Windows NT Server Domains, see the Administrator’s Guide .
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Platform-Specific Information Relating to Installation

This section provides information that varies from platform to platform. The
Installation Guide for the ClearCase Product Family specifies when you will need this
information and defines the terms used in this section.

Operating System Vendor Web Site

You can find up-to-date information on Microsoft Windows operating system issues
at the Microsoft Web site, www.microsoft.com.

ClearCase and MultiSite Patches Incorporated in This Release

ClearCase Version 2002.05.00 and ClearCase MultiSite Version 2002.05.00 include
all the patches listed in Table 6. If you are using a more recent patch on any of the
patch streams listed, contact Rational Technical Support to see whether there is a
corresponding patch for Version 2002.05.00.

Table 6 ClearCase and MultiSite Patches Incorporated into This Release

Patch stream Last patch incorporated into this release

ClearCase v4.0 clearcase_p4.0.NT-27 and earlier

ClearCase v4.1 clearcase_p4.1NT-21 and earlier

ClearCase v4.2 clearcase_p4.2.NT-5 and earlier

MultiSite v4.0 multisite_p4.0.NT-5 and earlier

MultiSite v4.1 multisite_p4.1.NT-5 and earlier

MultiSite v4.2 multisite_p4.2.NT-2 and earlier

Upgrading from a Previous Release

If you have a version of ClearCase prior to Release 4.0 installed, you cannot upgrade
directly to Version 2002.05.00, but must upgrade to any one of the Release 4.x versions
first.

To upgrade to Release 4.x, see the 4.x ClearCase and MultiSite Release Notes.

Upgrading to Version 2002.05.00 does not require reformatting your VOBs, unless
you are installing with the newer VOB format (schema 54). For more information
on general VOB database structure, and for details on reformatting a VOB, see the
Administrator’s Guide for Rational ClearCase and the reformatvob reference page.
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Upgrading to Version 2002.05.00 from a release prior to 4.1 does require upgrading
your storage locations; Release 4.1 added enhanced support for creating and managing
storage locations. For details, see the section below on Upgrading Storage Locations.

General Issues with Upgrading

The Installation Guide for the ClearCase Product Family provides information
necessary to install the ClearCase family of products. Here is some general
information to keep in mind about upgrading:

Make sure that all views and VOBs are fully backed up. For information on
backing up VOBs and views, see the Administrator’s Guide for Rational ClearCase.

You do not need to upgrade your license server or get new ClearCase licenses.
Licenses work with any version of ClearCase product family software, and
ClearCase Version 2002.05.00 hosts can use a ClearCase license server running
a 4.x version of the software.

Be sure that VOB and view servers are upgraded before you upgrade client hosts;
Version 2002.05.00 clients cannot access VOBs or views on hosts that are running
an earlier release of ClearCase.

Updating your VOBs to use the latest VOB database schema (schema 54) requires
that you reformat them. We recommend updating your VOB database schema
only if your site clearly needs support for greater than 16 million records and
VOB database file sizes greater than 2 GB, or the improved user ID representation
provided by SIDs. The installation procedure provides more information on this
topic.

Caution: If you use MultiSite and update one or more replicas in a VOB family to
the new format, you must update all other replicas in the family before
the reformatted replicas exceed the database limit of the previous
schema (53). If you do not, synchronization imports will fail at any
replica that has not been updated.

If you have modified any files in ccase-home-dir (C:\Program Files\Rational \ClearCase,
by default), move them; if you do not, they will be lost when you install.

We recommend that you not uninstall the previous version of ClearCase before
upgrading to Version 2002.05.00 or downgrading from this version to an earlier
one. The ClearCase install process has the ability to detect an existing copy
of ClearCase and carry forward certain customized settings. If you uninstall
ClearCase, these customized settings will be lost.

Before upgrading to a new ClearCase release, you must complete all deliver
operations that are in progress.

See also Known Issues Related to Installation on page 14.
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Upgrading to the New Feature Level for UCM PVOBs

This version of ClearCase introduces a new feature level, FL3, to support some of its
new functionality. To upgrade to the new feature level, you must upgrade systems to
the new feature level in the correct order after installing Version 2002.05.00 on all the
view and VOB server systems. If you are using UCM, this order is different from the
order required at previous releases of ClearCase and MultiSite. The order is:

1 Upgrade the license server to FL3.

2 Upgrade the registry server to FL3.

3 Upgrade VOB servers on all replicas to FL3.

4 Upgrade view servers on all replicas to FL3.

5 Upgrade all client systems to Version 2002.05.00.

6 Upgrade PVOBs and VOB families to FL3.

Note that in a UCM environment, if you do not perform Step 5, client systems that
have not been upgraded to the new release will not operate.

If servers are upgraded to the Version 2002.05.00 before all client systems have beem
upgraded, new VOBs must be created on servers that run ClearCase Release 4.x,
because Release 4.x clients cannot communicate with VOBs created on systems that
run the new release.

Once you upgrade the feature level on your PVOBs, you must also set the
recommended baselines on integration streams that are in use. If you do not, existing
development stream configurations may be unexpectedly changed when you perform
a rebase -recommend command.

For more information, see the ClearCase white paper on migrating to Version
2002.05.00 on the Rational Web site, www.rational.com/support/products/clearcase.jsp.

Evaluating This Release of ClearCase

The way in which you evaluate Version 2002.05.00 depends on which release of
ClearCase you are currently running.

If you are running a 4.x release and you want to evaluate Version 2002.05.00, you
can install this version on one or more test systems in your existing environment
of servers, clients, views, and VOBs, and configure the test systems to use your 4.x
license server.

Alternatively, you can install Version 2002.05.00 in evaluation mode on a test system.
For more information on evaluation mode, see the Installation Guide for the ClearCase
Product Family.
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Feature Compatibility Issues Across Releases

Even the simplest ClearCase operation invokes a communications chain that can
involve several components. For example, the act of checking out a file element
involves a client program (running on the developer’s workstation), which acts
through a particular view (located on that workstation or elsewhere) and uses
a particular VOB (typically located on a dedicated VOB server host). If all the
components in this operation are running the same ClearCase release, compatibility
is guaranteed.

Table 7, Table 8, and Table 9 show the compatibility paths if all hosts are not running
the same ClearCase release. In these tables, client means ClearCase client software. In
each table, a component in a row can use a component in a column if there is a yes at
the intersection of the row and column. For example, Table 7 shows that a 4.x view
can use a 2002.05.00 VOB or a 4.x VOB, but a 2002.05.00 view cannot use a 4.x VOB.

Table 7 Compatibility: Views with VOBs

4.x VOB 2002.05.00 VOB

4.x view yes yes

2002.05.00 view no yes

Table 8 Compatibility: Clients with VOBs

4.x VOB 2002.05.00 VOB

4.x client yes yes

2002.05.00 client no yes

Table 9 Compatibility: Clients with Views

4.x View 2002.05.00 View

4.x client yes yes

2002.05.00 client no yes

Specifically, these tables make two points:

ClearCase 2002.05.00 clients can use only views and VOBs that reside on ClearCase
2002.05.00 hosts.

ClearCase 4.x clients can use views and VOBs that reside on 4.x or 2002.05.00 hosts.

In general, 4.x clients can access 4.x and 2002.05.00 servers, while 2002.05.00 clients
can access 2002.05.00 servers only. A notable exception is that 2002.05.00 clients and
servers will talk to 4.x albd_servers to support access to registry, license and other
administrative functions.
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A Version 2002.05.00 client on UNIX can access a VOB on Windows NT using a
snapshot view. However, the snapshot view storage directory and the VOB storage
directory must be on servers running Version 2002.05.00 or later.

Upgrading Storage Locations

Prior to Release 4.1, view and VOB storage locations were supported only on
Windows servers. Release 4.1 added enhanced support for creating and managing
storage locations. To enable Version 2002.05.00 clients to use storage locations set up
in a release prior to 4.1, you must upgrade those storage locations.

Upgrading a Storage Location from the Graphical User Interface

To upgrade a storage location:

1 On a Version 2002.05.00 Windows server, start the ClearCase Server Storage
Configuration Wizard from ccase-home-dir\etc\SvrStor.exe.

2 Select Yes, start storage configuration now. Click OK.

3 On the second page of the wizard, select the UNC path of the storage location that
you want to upgrade, and click Add.

The Storage Location Attributes dialog box appears.

4 Enter a name for the storage location. Click OK.

5 Click Next and then Finish.

Upgrading a Storage Location from the Command-Line Interface

To upgrade a storage location:

1 On a Version 2002.05.00 Windows client, issue the cleartool mkstgloc command.
Specify the path of the existing storage location and the name of the storage
location. For example:

cleartool mkstgloc –view upgraded_views \\saturn\bert\stgloc\vws

ClearCase recognizes that you are upgrading an existing storage location and
prompts:

Advertise “old” Server Storage Location
“\\saturn\bert\stgloc\vws”? [no]y

2 Enter y to have ClearCase register (advertise) the storage location with the new
name.
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Upgrading Storage Location for Interoperation Snapshot View
Scenario

When you create a snapshot view, you can locate the view’s storage directory either
under the snapshot view’s root directory or in a storage location. If you create a
snapshot view on a ClearCase Release 4.2 client on UNIX, you can place the view’s
storage directory in an existing storage location on a Windows server if you take
the following steps:

1 Upgrade the Windows server to ClearCase Release 4.2.

2 Upgrade the existing (pre-4.1) storage location from an interface as described
earlier in Upgrading a Storage Location from the Graphical User Interface or Upgrading
a Storage Location from the Command-Line Interface.

VOB Schema Version 54 and Microsoft Active Directory

Rational recommends that you reformat your VOBs to use schema version 54 as
soon as possible. If you are considering conversion or migration to Microsoft Active
Directory, schema 54 is required. Schema version 54 provides improved support for
multiple domains, domain migration, as well as supporting ClearCase use with an
Active Directory.

Upgrading from ClearCase LT

Rational ClearCase LT can be easily upgraded to full-featured Rational ClearCase.
ClearCase includes a tool that helps automate the upgrade process, though a few
manual steps may be required to upgrade certain configurations. The upgrade
preserves all of your ClearCase LT VOB data.

The chapter Upgrading ClearCase LT to ClearCase in the Installation Guide for the
ClearCase Product Family explains the upgrade process in detail and describes two
common upgrade scenarios.

MultiSite Compatibility with ClearCase

ClearCase MultiSite is layered on ClearCase. To use MultiSite on a host running
Version 2002.05.00 of ClearCase, you must be running Version 2002.05.00 of MultiSite.

MultiSite Version 2002.05.00

ClearCase MultiSite Version 2002.05.00 is fully compatible with ClearCase Version
2002.05.00 client and server hosts:
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A MultiSite 2002.05.00 replicated VOB can reside on any ClearCase 2002.05.00
server host.

Any ClearCase Version 2002.05.00 client program can access and modify any
replicated VOB residing on a ClearCase 2002.05.00 or 4.x server host. Other
client-VOB access is the same as that documented in Feature Compatibility Issues
Across Releases on page 10.

Installing MultiSite 2002.05.00 does not require you to reformat VOBs or views.

Compatibility Issues Across MultiSite Releases

The following sections describe compatibility restrictions and issues when different
sites are running different MultiSite releases.

Replica Creation

There are compatibility restrictions on creating replicas. You cannot create a replica
on a Release 4.x host from a replica-creation packet created on a Version 2002.05.00
host. If you want to create a new VOB family with replicas on Release 4.x and Version
2002.05.00 hosts, the VOB from which you export the replica-creation packet must be
located on a host running Release 4.x.

Replica Synchronization

Existing replicas hosted on systems running ClearCase 2002.05.00 can synchronize
with existing replicas on systems running ClearCase 4.x. See the information on
feature levels in the Administrator’s Guide for Rational ClearCase MultiSite.

Upgrading to New Schema Format

If you decide to update one or more replicas in a VOB family to use the latest VOB
database schema format (schema 54), you do not have to update all other replicas in
the VOB family at the same time. However, you must update all other replicas in
the family before the reformatted replicas exceed the database limit of the previous
schema (53). If you do not, synchronization imports will fail at any replica that has
not been updated.

Enabling VOB Replicas for Interoperation

In ClearCase Releases 4.1 and later, VOBs are enabled for interoperation (MS-DOS
text mode) by default. When you create a new VOB on a host running Release 4.1 or
later, the VOB is enabled for interoperation. However, when you create a new replica,
the new replica gets the same text-mode property as the original VOB.
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For example, you run mkreplica –export on a Release 4.0 host to replicate a VOB that is
not enabled for interoperation, and then run mkreplica –import on a Version 2002.05.00
host. The new VOB replica is not enabled for interoperation.

Note: When you replicate a VOB, the new replica has the same text-mode property
as the original VOB, but changes to the text mode are not included in synchronization
update packets.

ClearQuest Compatibility with ClearCase

ClearCase and MultiSite Version 2002.05.00 can be integrated with Rational
ClearQuest software in two different ways:

If you are using ClearCase with the Unified Change Management (UCM) process,
a UCM-ClearQuest integration is built in to this release; you can use it with
ClearQuest Version 2002.05.00.

If you are using base ClearCase (that is, not using the UCM process), you can
integrate with ClearQuest 2001A.04.00 or later using the ClearCase-ClearQuest
integration 1.0.

Installation and Licensing

This section contains an overview of information on installing and licensing ClearCase
and MultiSite software.

Pointer to Installation and Licensing Information

See the Installation Guide for the ClearCase Product Family for detailed information
about installing and licensing ClearCase and MultiSite software.

Known Issues Related to Installation

This section discusses restrictions or defects that involve the installation of the
ClearCase product. Take into account the information in this section before or during
installation to be sure that ClearCase software or particular features are installed
properly.

Installing Java VM with Internet Explorer

A Java virtual machine (VM) is required for the ClearCase Web interface. However,
recent versions of Microsoft Internet Explorer no longer install the VM by default. For
these versions, you must perform a custom installation of IE, selecting the Microsoft
virtual machine component.
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Setting Up the VisualAge for Java Integration

The ClearCase integration with Visual Age for Java enables you to use ClearCase
source control functions, such as checking out, modifying, and checking in your files,
without leaving the Visual Age for Java IDE or starting another application.

To use the VisualAge for Java ClearCase integration, you must install both VisualAge
for Java and ClearCase, in either order, and then run the VisualAge for Java Integration
Configuration Wizard. This section describes all three procedures.

Installing VisualAge for Java

1 Run the installation program for IBM VisualAge for Java Version 3.5, Enterprise
Edition. Follow the installation instructions and prompts.

2 During the installation, select the Custom option. In the list of components to
install, select the External Version Control option.

3 Download and install the latest patch from www.ibm.com for the VisualAge for
Java Version 3.5, Enterprise Edition.

Installing ClearCase

If ClearCase is already installed and running on your system, skip this procedure.
If ClearCase is not installed, install it as you normally would, with the addition of
the following steps.

1 Step through the installation to the Standard or Custom Client Configuration window.
Click I will create my own custom client configuration, and click Next and continue
with the installation.

2 In the Site Defaults window, click No, I will customize this ClearCase installation. Click
Next and continue with the installation.

3 In the Start Menu Entries window, locate the list of ClearCase Administration Start
Menu entries. Click VisualAge for Java Integration Configuration. Click Next and finish
the ClearCase installation.

Running the Configuration Wizard

After both VisualAge for Java and ClearCase are installed, you must run the VisualAge
for Java Integration Configuration Wizard. Select one of the methods listed here.

If you installed ClearCase using the procedure titled Installing ClearCase in this
section:
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In your Windows taskbar, click Start>Programs>Rational ClearCase

Administration>Integrations>VisualAge for Java Integration Configuration.

If ClearCase was previously installed or if the VisualAge for Java Integration
Configuration shortcut menu does not appear in the Integrations menu:

1 In your Windows Taskbar, click Start>Run.

2 In the Run window, enter the path to the file, vaj_config.exe, in the bin
folder of your ClearCase installation. For example, a typical path is
C:\Program Files\Rational \Clearcase\bin\vaj_config.exe.

3 Click OK.

Set CLEARCASE_PRIMARY_GROUP on Windows Systems

ClearCase access controls consider domain group membership information when
determining a user’s rights to access ClearCase data. Because of a bug in Windows NT,
a user who logs on to a domain account may not be assigned the primary group
specified by the Windows NT domain account management tools.

To work around this bug, we recommend that you set the user environment variable
CLEARCASE_PRIMARY_GROUP to refer to the correct primary group. The value of
this variable must be the name of an existing domain group that meets all of the
following requirements:

It includes the user as a member.

It appears on the user’s group list.

This environment variable must be set on every ClearCase host. On Windows NT
systems, you set the value of CLEARCASE_PRIMARY_GROUP using the System icon
in the Control Panel. On Windows 98 or Windows Me systems, you must set the
value of CLEARCASE_PRIMARY_GROUP in the autoexec.bat file on each system that
runs ClearCase.

For more information on CLEARCASE_PRIMARY_GROUP and ClearCase access
controls, see the Administrator’s Guide for Rational ClearCase.

Dual-Boot Installation Failure

When installing ClearCase in Windows NT on a dual-boot computer (Windows NT or
Windows 98), the installation encounters an assertion failure.

At the beginning of the installation, an error message appears stating something
like this:

Assertion failed!
Program: path-name
File: file-name
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Line: line-number
Expression: "Function not implemented: " ...
For information on how your program can cause an assertion failure,

see the Visual C++ documentation on asserts.
(Press Retry to debug the application – JIT must be enabled.)

The message box contains three buttons: Abort, Retry, and Ignore.

Workaround: Follow this procedure to complete the installation:

1 Abort the installation (click Abort in the message box).

2 In the Windows NT registry, set the following registry key to 0:

HKEY_CURRENT_USER\SOFTWARE\Microsoft\Windows NT\CurrentVersion\

WinLogon\ParseAutoexec

3 Reinstall ClearCase.

Slashes in Installation Directory Not Supported

The ClearCase Installation Directory box in the ClearCase Installation Wizard does not
support slashes (/).

Reinstall MultiSite If Rational ClearQuest Shipping Server Is
Uninstalled

If you are using ClearCase MultiSite and the Rational ClearQuest Shipping Server
on the same computer and uninstall one of those products, the other is partially
uninstalled and stops working. Uninstall both and reinstall the product that is needed.

Deinstalling ClearCase May Remove Web Interface Views

By default, views for Web interface users are created under the host data directory
for ClearCase (ccase-home-dir\var). If ClearCase is deinstalled, the view directories are
deleted, but the views remain registered. To avoid leaving entries for nonexistent
views in the ClearCase registry, do one of the following:

Remove any views created by Web interface users before you remove ClearCase
from a Web server that is used to provide access to the ClearCase Web interface.

Use the –view_storage option in the ccweb.conf file to designate some other location
for Web interface views.

Installation of UCM Integration with ClearQuest

To use the UCM integration with Rational ClearQuest, take into account the following
issues with the compatibility and version support of the following elements:
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ClearCase version (client and server)

ClearQuest version

UCM schema package

ClearQuest metaschema feature level

Consider the following points:

The feature level of the metaschema for ClearQuest 2001.03.00 database is 3. The
feature level for ClearQuest 2001A.04.00 or 2002.05.00 database is 5.

A ClearCase 2002.05.00 client requires either a ClearQuest 2001A.04.00 or a
ClearQuest 2002.05.00 client, because the integration of UCM with ClearQuest
uses new ClearQuest API calls.

Table 10 shows the compatibility of different releases of ClearCase and ClearQuest,
the UCM package revision number, and the ClearQuest database feature level.

Table 10 Supported Integrations Between ClearCase (Using UCM) and
ClearQuest

ClearCase release ClearQuest releases
UCM package
revision numbers

ClearQuest
database feature
levels

Release 4.1 2000.02.10, 2001.03.00 2.0 3

Release 4.2 2001A.04.00,
2001A.04.20, 2002.05.00

2.0, 3.0 3, 5

Release 4.2 +
patch

2001A.04.00,
2001A.04.20, 2002.05.00

2.0, 3.0, 4.0 3, 5

Version
2002.05.00

2001A.04.00,
2001A.04.20, 2002.05.00

2.0, 3.0, 4.0 3, 5

To upgrade to Release 4.2 from 4.1 and continue to use your integration of UCM with
ClearQuest, you must perform the first two steps. The last two steps are optional.

1 Install ClearQuest.

2 Install the ClearCase client (or both ClearQuest and ClearCase simultaneously).

3 Upgrade your UCM-enabled ClearQuest schema with the new version of the
UnifiedChangeManagement package.

4 Upgrade your ClearQuest user database to the new version of the schema.
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ClearCase Client Computers Need Consistent Character Encoding

All ClearCase client computers that access a common set of VOBs and views must use
a single common character encoding system. If all computers are not configured this
way, ClearCase operations may fail or produce confusing or unreadable output.

For example, the Japanese SJIS and Japanese EUC encoding systems are available.
They both represent Japanese characters but are incompatible. For this reason, you
cannot mix SJIS and EUC in ClearCase clients.

Intermittent Problem with ALBD Server During Installation

Occasionally, when you install Version 2002.05.00, the installation may display the
following error message:
Error 1069: ClearCase ALBD could not log in due to wrong password

(Note that you may have to check the Event Viewer in order to see this error.)

If you see this error message, follow the steps below to correct the problem:

1 Click Control Panel>Services. (On Windows 2000, click Control Panel>Administrative
Tools>Services).

2 Select Atria Location Broker.

3 Click Startup. (On Windows 2000, click Action>Start).

4 Type a new password in the Password box, and confirm it in the Confirm Password
box.

5 Click OK.

6 Click Start.

Attempt to Replace Read-Only sitedefs.dat File Silently Fails

Site preparation may fail to replace an existing sitedefs.dat in a release area, if either the
file or whole directory is set to read-only by the network (and not by the file attributes).
If this happens, no error is reported. Instead, the install reports that the siteprep has
completed successfully, in spite of the fact that the sitedefs.dat file is not updated.

DDTS Integration Uses Wrong Environment Variable

The DDTS trigger scripts use the CLEARCASE_PNAME environment variable, but this
EV is not set. Instead, the CLEARCASE_PN EV is set to the correct value.

Workaround: Set CLEARCASE_PNAME to CLEARCASE_PN at the beginning of each
trigger that uses the EV.
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Notice for expat XML parser

This product incorporates the expat XML parser 1.0 under the Mozilla 1.1 license
available at www.mozilla.org/MPL/MPL-1.1.txt. The source code version of the expat XML
parser is available at www.jclark.com/xml/expat.html.
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What’s New in
ClearCase 2

This chapter summarizes significant new and changed features in Version 2002.05.00
of Rational ClearCase.

Summary of Changes in This Release

This version of ClearCase introduces the following significant new and changed
features:

New UCM Features

Enhanced ClearCase Web Interface Support

Enhancements to XML DiffMerge

Enhancements to ClearCase Explorer

Enhancement to UCM ClearCase-ClearQuest Integration

Enhancements to Base ClearCase-ClearQuest Integration

Enhancements to ClearCase Integrations with Third-Party Products

Enhancements to Installation

clearmake Changes, including support for Parallel Builds on Windows

Support for Microsoft Active Directories

Support for Microsoft Windows Terminal Server

GUI Support for Date and Time Preservation

Additional Support for Moving VOBS

New View Database Format

Changes to Administration Console

Enhancement to Apply Label Wizard

Changes to ClearCase Commands

New ClearCase Perl Module
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Changes to ClearCase Commands

Changes to Documentation

New UCM Features

This section describes the main changes to UCM in this version of ClearCase.

Development Stream Hierarchies

In the basic UCM process, the integration stream is the project’s only shared work
area. You may want to create additional shared work areas for developers who work
together on specific parts of the project. Now you can accomplish this by creating a
hierarchy of development streams. For example, you can create a development stream
and designate it as the shared work area for the developers working on a particular
feature. Developers then create their own development streams and views under the
feature-specific development stream. In other words, the developers join the project at
the feature-specific development stream level rather than at the integration stream
level. The developers deliver work to the feature-specific development stream and
rebase their streams to recommended baselines in the that development stream.

Interproject and Intraproject Deliver Operations

You can now deliver work from an integration stream or a development stream in one
project to an integration stream or development stream in another project. In addition,
you can deliver work from one development stream to another within a project. These
features make it easier to manage related areas of development within a project,
and parallel releases of multiple projects.

Nondefault Deliver Target Policies

The default target for a deliver operation is the source stream’s parent stream. You
can also deliver work to nondefault target streams. Because any stream can now be
the target of a deliver operation, this release adds several policies that you can set on
streams to control what kind of deliver operations the target stream will accept. For
example, you can set a policy to reject deliver operations that contain changes to
components that are not in the target stream’s configuration. You can set these policies
at the project level so that the policy settings apply to all streams within the project, or
you can set the policies on a per-stream basis.

Composite Baselines

A baseline selects one version of every element visible in a component. This release
lets you create composite baselines. A composite baseline is a baseline that selects
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baselines from other components. By creating a composite baseline that selects
baselines from every component in your project, you can use one baseline to represent
the entire project.

After you create a composite baseline to represent the project, the next time you
invoke the make baseline operation on the composite baseline, UCM performs the
operation recursively. If a component that contributes to the composite baseline has
changed since its latest baseline, UCM creates a new baseline in that component.

A composite baseline can select other composite baselines. This feature allows you to
use a composite baseline to represent a system that consists of multiple projects. The
system-level composite baseline can select project-level composite baselines.

Multiple-Component VOBs

You now have greater flexibility in storing components in VOBs. For example, you
can now store multiple components in a VOB. Within a VOB you can make an existing
directory tree into a component. The component’s root directory must be the VOB’s
root directory or one level beneath it. To store multiple components within a VOB,
each component’s root directory must be one level beneath the VOB’s root directory.

Support for Triggers on Additional UCM Operations

This release adds support for triggers to the following UCM operations
chbl
chfolder
chproject
chstream
mkcomp
mkfolder
mkproject
rmbl
rmcomp
rmfolder
rmproject
rmstream
setplevel

Other New Features

Other new features in this product release include:

Ability to deliver selected baselines from a stream

Deliver from Stream Preview Option. The Deliver from Stream Preview dialog
box now gives you the option to pause the merge to allow you to perform any
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merge-related activities. If you select this option, the merge operation stops after it
identifies the versions that require merging, checks out all versions, and performs
all directory merges. You can then perform any operations related to the merge.
When you are finished, continue the deliver operation.

Enhanced ClearCase Web Interface Support

This version of ClearCase provides a number of enhancements to the ClearCase Web
interface.

UCM Support

This version of the ClearCase Web interface supports the UCM developer role. A
developer can use the Web interface to join a project, create new activities, perform
work in those activities, deliver work to an integration stream, and rebase a
development stream to recommended baselines.

Web-Based Diff/Merge Capability

Performing the UCM rebase or deliver operation requires the ability to merge changes
in files. The ClearCase DiffMerge tool has been implemented for this purpose within
the Web interface context. The DiffMerge tool is called automatically when you do a
rebase or deliver operation from within the Web interface; you canalso run the Merge
Manager directly from the Web interface toolbar.

Improved Workspace Management for Web Views

ClearCase now provides workspace management capabilities for Web views which
are similar to those for standard ClearCase snapshot view functionality on a local
copy of element versions.

Improved Control Over Session Timeout Length

A new configuration variable has been added to the ccweb.conf file to control the
length of time that elapses before an unattended ClearCase Web session times out.
The new variable is ‘–session_timeout age_in_seconds’ where the minimum value for
age_in_seconds is 600 (10 minutes) and the default value is 14400 (4 hours).

Interop Text Mode Supported in Web View Creation

It is now possible to specify “interop text mode” as a characteristic of a ClearCase Web
view during the view creation process.
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Web Server Component Installation iIs Now Optional

Installing the ClearCase Web server components is now optional; previously these
components had been installed on all systems.

If you are installing a ClearCase server, the ClearCase Server Options window now
includes a check box for installing Web Server Interface Components; the default is to
install the option If you are installing a ClearCase client, you must select a Custom
installation to install the Web interface components. First select Custom on the Select

Configuration dialog, then select the component as desired on the subsequent Choose

Features dialog. a new option has been added to the installation.

Changes to Web Interface Documentation

The online help for the ClearCase Web interface has been updated to reflect the
enhanced functionality of this feature. In addition, the chapter Configuring a Web
Server for the ClearCase Interface in the Administrator’s Guide for Rational ClearCase
contains updated information on configuring the ClearCase Web server.

Enhancements to XML DiffMerge

The XML Diff Merge applet contains the following new features and enhancements
for comparing and merging XML files:

Completely new graphical interface, more closely resembling the GUI for the
other ClearCase DiffMerge tools.

Improved difference computation

faster and more efficient

More powerful ID-matching technology for record-oriented XML data

More accurate evaluation of differences can merge attribute values from
different contributors automatically

Compares and merges both XML structure and content, including attribute values

Supports editing of node values, including text nodes, attribute values, comments,
CDATA sections, and processing instructions; can accept, reject, or change conflict
resolution decisions and/or automatically resolved merges.

Provides a side-by-side display of all contributors, along with a merge view that
contains only the elements selected by the merge. Expands, collapses, browses,
and filters the data tree resulting from a comparison or merge operation.

Merges result in well-formed XML output documents.
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Full support for all ClearCase type manager operations; allows automated or
manual merge (with –query and –qall options)

XML Browser window lets you view XML documents using CSS or XSL
stylesheets.

Improved whitespace handling. For example, XML Diff Merge ignores spurious
differences caused by nonterminal whitespace, and enables you to preserve
indents.

Support for UNICODE characters, as well as ASCII, ISO-8859-1, UTF-8, and
UTF-16 output encodings.

For more information, see the xmldiffmrg reference page and the online help. The
xmldiffmrg reference page is a new addition to the Command Reference at this release,
and the xmldiffmrg online help has been substantially revised to reflect the tool’s
new functionality.

Enhancements to ClearCase Explorer

ClearCase Explorer includes the following new features and enhancements:

ClearCase Explorer shortcuts enable you to start other tools by clicking an icon in
the Shortcut pane. Site-defined shortcuts can now be configured to be available to
different groups and classes of users.

The Information pane now dynamically displays content that is tailored to the
user ’s current environment, including either online help information about the
current context, or useful information about the item selected in the details list.

The shortcut menu on ClearCase Explorer supports a command to create a
symbolic link. Right-click in the Details pane of the directory in which you want to
create the symbolic link and click Symlinks>Create Symlinks to access the feature.

The shortcut menu in the folder pane of the ClearCase Explorer includes a
command to search for files. Right-click in the Folder pane and click Search. This
starts the Windows Find utility, which you can use to specify the attributes of the
search. In the Find: All Files results window, you can use the shortcut menu to
perform ClearCase operations on the selected files.

Online help for ClearCase Explorer has been updated to reflect the new functionality.

Enhancement to UCM ClearCase-ClearQuest Integration

The UCM ClearCase-ClearQuest integration has been enhanced to support
relationships betweens a single PVOB and multiple ClearQuest user databases.
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In previous versions of the software, all UCM ClearCase projects controlled by a single
PVOB had to point to the same ClearQuest user database. Now different projects can
point to different user databases, even if they are all controlled by a single PVOB.

Enhancements to Base ClearCase-ClearQuest Integration

This release adds a new version of the base ClearCase-ClearQuest integration, which
allows you to associate versions of ClearCase elements with change requests in a
ClearQuest user database.

The integration uses triggers on ClearCase commands to allow developers to associate
versions with change requests. In previous releases, the integration used a Visual
Basic trigger on Windows clients and a Perl trigger on UNIX clients. This release adds
a new Perl library, including a trigger, that runs on Windows and UNIX. The new
integration provides the following benefits:

Support for UNIX and Windows platforms is now in a common code base.

The integration is implemented as a set of object classes that provide modularity,
extensibility, and reusability. The integration loads optional classes dynamically
depending on the client environment. For example, if ClearQuest is not installed
on a client, the integration does not load classes that support the ClearQuest Perl
application programming interface (API).

Performance has been improved by eliminating unnecessary communications
operations.

Windows clients no longer need ClearQuest installed to access ClearQuest user
databases. Like UNIX clients, Windows clients can now use the ClearQuest Web
Interface to connect to ClearQuest.

Because the integration supports the ClearQuest Perl API, ClearCase clients on
UNIX can now, like Windows clients, access Oracle user databases on ClearQuest
hosts that run on UNIX. This provides enhanced support for customization by
administrators, because changeable data is isolated from other layers of the
interface.

ClearQuest MultiSite support is provided through optional checking of change
request mastership.

Note: The new integration provides a text-based user interface for developers
who use the cleartool command-line interface and a clearprompt pop-up window
user interface for developers who use one of the ClearCase GUIs such as ClearCase
Explorer (on Windows) or xclearcase (on UNIX). The new integration does not
provide a GUI for developers. For Windows client hosts that have ClearQuest
installed, you may want to use the existing integration that uses a Visual Basic trigger
to provide a GUI for developers.
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Enhancements to ClearCase Integrations with Third-Party
Products

This version of ClearCase includes the following new or improved integrations with
third-party products:

PowerBuilder Enhancements

Forte Developer (C++ IDE) Support

VisualStudio.NET (V7) (SCC support)

Microsoft Word Enhancements

Note: In addition to enhancements to specific integrations, all ClearCase
integrations to third party products that use the SCC API now have support for the
–ptime option. This option preserves the file modify time so that interactions with
ClearCase do not update the file modify time. This option defaults to the site specific
setting, but can be changed through the options menu to give a user default. The
option can also be set for each Add, Checkin or Checkout operation through the
advanced options button

Sybase PowerBuilder Enhancements

The ClearCase PowerBuilder integration has been enhanced to fully automate the
deliver and rebase operations. Users can now perform deliver and rebase operations
on PowerBuilder Library (PBL) objects. They can also recreate PBLs from versioned
objects.

Sun Forte for C++ Support

Forte Developer V6.0 now supports a ClearCase integration. This integration provides
a set of commands and tools that allow a software development team to share, control
and track files created with Forte Developer.

Using this integration, you can check out, modify, and check in your files without
leaving the Forte Developer IDE or starting another application. You can also use this
integration to access files under version control.

You can access commands and tools supported by the integration from the Forte
Developer’s Tools menu.

The following ClearCase commands and tools are available:

Add to Source Control

Check In

28 Chapter 2 - What’s New in ClearCase



Check Out

Compare

Properties

Source Control History

Undo Check Out

Version Tree

Help

The above commands and tools give you all the capabilities you generally need.

Microsoft VisualStudio.NET (V7) (SCC support)

This version of ClearCase provides an SCC-level integration of ClearCase functionality
with Microsoft’s Visual Studio version 7 (Visual Studio.NET). Support for the
ClearCase toolbar add-in will be available through a ClearCase patch.

Microsoft Word Support

ClearCase Version 2002.05.00 includes an updated integration with Microsoft Word
that uses a COM add-in. Because the COM technology is incompatible with Word 97,
this new integration only works with Word 2000 or Word XP.

However, the old integration is not removed if Word 97 is still installed. If both Word
97 and Word 2000/Word XP are installed, the old integration continues to work with
Word 97, while the new integration is installed for use with Word 2000/Word XP.

Enhancements to Installation

This version of Rational ClearCase includes the following enhancements to
installation.

Implementing Installation through the Silent Install

Silent install is a method of installing Rational ClearCase on client systems, without
intervention from users. The silent install greatly reduces the work of an administrator
during a rollout of ClearCase. It also ensures that the correct software configuration is
installed on each target system. The procedures and guidelines for implementing the
silent install are available in the Installation Guide for the ClearCase Product Family.
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Installation Process Now Runs the ClearCase LT Upgrade Tool

When upgrading from ClearCase LT to full-featured ClearCase, the installation
process now runs the ClearCase LT upgrade tool in the background instead of having
the user invoke it from the command line. More information on the ClearCase LT
upgrade tool is available in the Installation Guide for the ClearCase Product Family.

Note: You can not install standard ClearCase on a system that currently has
ClearCase LT installed; you must uninstall ClearCase LT first.

VOB Database Format Upgraded Correctly to Scheme 54 During Install

Previous versions of ClearCase did not upgrade the VOB database format to schema
54 when specified in the Site Preparation Wizard. In this version, ClearCase does
perform the upgrade to schema 54. It also displays a message reminding users to
reformat the VOBs stored on the local machine, as a result of the upgrade.

New ClearCase Site Preparation Option

During ClearCase site preparation, when setting site-specific defaults, you can define
the tool shortcuts definition file for ClearCase Explorer (see Enhancements to ClearCase
Explorer on page 26). This file allows you to remove shortcuts that Rational defines
and substitute your own for a site and add shortcuts to locally used tools and URLs.

Installation Can Now Create an Installation Log File

The installation program has been enhanced to produce a log file that documents
the installation process. This file includes information about the version of the
installation program used, the ClearCase LT configuration installed, the files and
patches installed, and the completion status.

The installation log is created by setting the /log option when invoking the setup
command. The log file is written to the location ccase-home-dir\install\ccsetup.log.

More information on generating and viewing ccsetup.log is described in the
Installation Guide.

Additional MVFS Settings Available

The MVFS Settings dialog box in the ClearCase Site Preparation Wizard and the
ClearCase Installation wizards now allow you to specify two additional settings:

The maximum number of mnodes to keep on the VOB free list.

The maximum number of mnodes to keep for the cleartext free list.

For considerations in selecting the values of these settings, see the online help. You
can also modify these settings from the ClearCase Control Panel.
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Installation Will Carry Forward Custom Type Managers

In this version of ClearCase, the installation process will carry forward custom type
managers that had been installed under previous versions. Note that a copy of the
ccase-home-dir\lib\mgrs\map file is saved under the name map.save, and information
about the action taken is written to the ccsetup.log file, when it is generated

Leading and Trailing Spaces Ignored in ClearCase_ALBD Account Name

In earlier versions of ClearCase, a ClearCase_ALBD account name inadvertently
entered with a blank space at the beginning or end was treated as a unique account
name separate from the same name entered without the space. Now spaces at the
beginning or end of the ClearCase_ALBD account name will be ignored.

clearmake Changes

This release provides enhancements to clearmake that do the following:

Support parallel builds on Windows NT systems

Record makefile versions within configuration records.

Improve reporting.

Support for Parallel Builds on Windows NT Systems

This release supports ClearCase execution of parallel builds on Windows NT
platforms when using clearmake. ClearCase can perform builds in which multiple
processes execute in parallel the build scripts associated with makefile targets.
The processes that execute the build scripts must all run on a single machine. By
using more concurrent processes, parallel builds can reduce the overall build time
significantly. Instead of one process running one script at a time, you can have
multiple processors working in parallel. Within large software systems, this feature
can substantially improve system performance. fFor more information, see the
Building Software manual (Windows Edition).

Recording makefiles within Configuration Records

clearmake now offers support to record the versions of makefiles, and optionally to
have changes to them affect reuse of derived objects. Two new makefile special targets
have been added: .MAKEFILES_IN_CONFIG_REC and .MAKEFILES_AFFECT_REUSE.
The .MAKEFILES_IN_CONFIG_REC special target causes makefiles read by a build
session to be recorded in the configuration record of all derived objects built during
that build session. You can use the .MAKEFILES_AFFECT_REUSE special target to
specify changes to makefiles as criteria affecting the reuse of derived objects during
builds. For more information, see the Building Software for Rational ClearCase.
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Improved Reporting

When clearmake rebuilds a target because a “build script mismatch” is detected, you
can now use the –d and –v options to generate a print of the actual script differences to
standard output.

Improved Handling of Special Characters in Macro Names

Clearmake -C gnu now allows special characters such as ";" to be used in macro names.

Improved Handling of Special Characters in Filenames

Clearmake now supports the use of special characters such as "$$" (as an equivalent
to a literal "$") or “\%” (as the string literal "%") in target names. This has been
implemented by default for -C gnu, and through the .JAVA_TGTS special target for
all other compatibility modes.

Support for Microsoft Active Directories

ClearCase is now fully compatible with Microsoft’s Active Directory and with
Windows NT domains. ClearCase also includes tools that support domain migration
and domain upgrade as described in the Microsoft white paper entitled Planning
Migration from Microsoft Windows NT to Microsoft Windows 2000.

Enhanced Support for Transitive Trusts in Multidomain Active Directory
Configurations

This release has enhanced support for sharing of dynamic views and VOBs across
complex Active Directory configurations.

This support makes it easier for a community of ClearCase users to share dynamic
views and VOBs across multiple Active Directory domains in a single forest. Earlier
ClearCase releases supported this capability, but may have required workarounds to
make dynamic views operate in multiple Active Directory domains in a single forest.
This release no longer requires workarounds such as creating direct trust relationships
or ensuring dynamic views have more liberal read/write access when created.

Support for Microsoft Windows Terminal Server

With this release, ClearCase supports snapshot views with the Microsoft Windows
Terminal Server, Microsoft’s "thin client" server-based technology. Dynamic views,
enabled by the MVFS, are not supported with the Windows Terminal Server.
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Note that ClearCase must be installed on the server after Windows Terminal Server
has been installed. If ClearCase was installed previously on the server, you must
remove ClearCase, install Windows Terminal Server, and then reinstall ClearCase.

In addition, if you are using UCM in ClearCase running on a Windows Terminal
Server, your installation can include only one administrative VOB (PVOB).

GUI Support for Date and Time Preservation

This release provides support for preserving the modification time of a file when
it is added to source control, checked out, or checked in using the ClearCase GUI.
The command-line interface, through the cleartool checkout, checkin, and mkelem
subcommands, already provided this functionality with the –ptime option.

Additional Support for Moving VOBS

ClearCase now supports new types of VOB move:

Moving a VOB to another Windows domain

Moving a VOB from Windows to UNIX

Moving a VOB from UNIX to Windows

The vob_sidwalk and vob_siddump tools enable you to read and change Windows SIDs
that are stored in schema 54 VOB databases. These tools are typically used for moving
VOBs from one Windows NT or Windows 2000 domain to another or to an Active
Directory domain, or for moving a VOB between a Windows host and a UNIX host.

For more information, see the vob_sidwalk reference page and the Administrator’s
Guide.

New View Database Format

This version of ClearCase uses a new view database format.

Existing view databases will be reformatted the first time the view is used after this
version of ClearCase is installed. You may also reformat the views manually using
cleartool reformatview. We recommend that you reformat views manually if they have
large databases. Doing so will minimize the chances that clients will experience view
access time-outs during the reformatting.

When a view database is reformatted, its size grows by about 50%, which increases
the size of the total view storage area by 10%.
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Note: After a view is reformatted to the new ClearCase format, it cannot be
reformatted to an earlier format.

Changes to Administration Console

In line with the transfer of ClearCase Web information from clearcase.rational.com
to www.rational.com, the URL pointed to by the Customer Site snap-in in the
Administration Console now points to www.rational.com.

Enhancement to Apply Label Wizard

The Apply Label Wizard now can label the target of a symlink. On Step 3 of the
wizard, under Follow VOB symbolic link, click Yes to have the wizard find the target of
symlink and apply the label to that version.

New ClearCase Perl Module

With this version of ClearCase, Rational is releasing a Perl module, CtCmd, to enable
users to access ClearCase calls directly from Perl scripts. CtCmd is a Perl extension to
cleartool that takes either a string or an array as input, and returns a three-element
array containing a status bit, a scalar string (if any), and any error message. The
module can be used to access all cleartool subcommands, but not the cleartool options
–ver and –verall.

CtCmd is distributed through the Comprehensive Perl Archive Network (CPAN) at
www.cpan.org. Our goal in developing CtCmd was to increase the speed and efficiency
by which users can write Perl programs that access ClearCase.

As with all CPAN modules, CtCmd must be built and installed by the user. For more
information, see the INSTALL file distributed with CtCmd. After you install the
module, detailed documentation is available by typing perldoc CtCmd.

Support for CtCmd is available through Rational Technical Support. Currently, the
module supports Windows NT and Windows 2000.

Other Enhancements

The following sections discuss additional enhancements made to this version of
ClearCase.
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chevent-Type Triggers Set to MODIFY_TYPE Now Fire Correctly

chevent type triggers now fire correctly when a trigger is set on MODIFY_TYPE. The
chevent operation for element triggers is now a sub-operation of the MODIFY_ELEM
operation rather than the MODIFY_MD and MODIFY_DATA operations that it fell
under previously.

New MVFS tuning parameter

Operations which enumerate the contents of VOB or view-private directories (such
as /bin/ls on UNIX, dir on Windows in a command shell,; or Explorer windows on
Windows) can be accelerated by MVFS caching of the directory contents. Directory
contents at the MVFS level are handled in blocks of entries. This value determines the
upper limit of how many blocks can be cached per directory. The default setting of 4
blocks is enough space for approximately 600 directory entries.

For more information, see the Administrator’s Guide.

clearfsimport Checks For VOB Locks During Operation

The clearimport command now checks for VOB locks before processing an element or
version. If it detects a VOB lock, it shows a message indicating that the VOB is locked
and that it will wait 60 seconds to retry. It remains in this state until either the VOB is
unlocked or the user interrupts the import.

rmelem Use Now Restricted to VOB Owner or Privileged User

Beginning with thise version of ClearCase, use of rmelem is restricted to the VOB
owner or privileged user unless no versions have metadata (labels, attributes, or
hyperlinks) and all branches were created by the user.

rmelem Triggers fire When Symbolic Link is Removed

Removing a VOB symbolic link with the rmelem command now causes all-element
rmelem triggers to fire. This works only for all-element trigger types and does not
work with per-instance triggers.

recoverview Now Dumps or Loads Very Large Views

The view_server now dumps and/or loads very large views. Previously it would fail
to dump or load a view if the dump file exceeded 2 GB in size. The view_server now
creates multiple dump files for very large views, each of which is limited to about
1 GB in size.
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Improved Error Reporting for diffbl

Previously, when diffbl failed comparing imported baselines, initial baselines, or
baselines/streams based off imported or initial baselines, against other similar
baselines or streams, it displayed confusing error messages. These messages described
the failure as resulting from the fact that the baselines or streams involved did “not
share a common ancestor (initial or imported) baseline”.

Now the error message describes the cause of the failure more accurately as resulting
from the fact that the baselines/streams “are derived from different import baselines
or the initial baseline”.

Changes to ClearCase Commands

This section describes new commands, changes to existing commands, and commands
that have been made obsolete in this release of the product.

New Commands

Table 11 lists new commands in this version of ClearCase. In addition, the clearprompt
command is now available as part of the minimal developer installation.

Table 11 New Command in ClearCase Version 2002.05.00

Command Description

vob_sidwalk/
vob_siddump

Read and change Windows SIDs that are stored in schema
54 VOB databases.

New Options and Arguments

Table 12 lists new options and arguments to commands in this version of Rational
ClearCase.

Table 12 New Options and Arguments to Existing ClearCase Commands

Command New Option/Argument Use

-follow Lists link targets onlycatcr

-scripts_only Lists configuration record header
and build script only

chbl –nrecurse Causes the changes specified by -full
or -incremental to only apply to the
composite and not its members
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Command New Option/Argument Use

chmaster –obsolete_replica
old-replica-selector

Transfers mastership of all objects
in the replica specified with
old-replica-selector

-dmodcomp component-
selector [,...]

Removes one or more modifiable
components

chproject

-spolicy policy-keyword [,...] Allows the specified policy to be
enabled or disabled by individual
streams in the project

–target stream-selector Sets the default deliver stream for an
integration stream only

–ntarget Clears the default deliver stream
setting

–generate Forces an update of the stream’s
copy of the config spec

–policy policy-keyword [,...] Enables the specified policy

–npolicy policy-keyword [,...] Disables the specified policy

–recommended
{baseline-selector {,...}}
| default}

Sets the list of recommended
baselines for the stream

chstream

–nrecommended
{baseline-selector {,...}}
| default}

Clears the list of recommended
baselines previously set in a stream
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Command New Option/Argument Use

–deliver [ -to target-view-tag ] Specifies a view attached to the
deliver target stream

–deliver [ -target
stream-selector ]

Specifies a non-default deliver target
in the same or a different project

–rebase [ -stream

stream-selector ]
Specifies a stream to be used as the
source for the UCM rebase operation

–directory For each directory, considers only the
directory itself, not the directory or
file versions or VOB symbolic links
it catalogs

–nrecurse For each directory version, considers
the file and directory versions within
it, but does not descend into its
subdirectories

–follow Causes VOB symbolic links to be
traversed

–noautomerge Turns off automated merging of
directories

–query Turns off automatic merging for
nontrivial merges and prompts you
to proceed with every change in the
from-versions

–qall Turns off automated merging.
Prompts you to determine whether
you want to proceed with each
change

clearmrgman

–file mrgman-file Loads the specified merge manager
file

clearprompt –n Allows use of ’\n’ to represent the
newline character .
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Command New Option/Argument Use

cleartool –status In interactive mode, returns the
status of each cleartool subcommand
executed.

describe replica-uuid-selector Displays the properties of a replica
by specifing its OID

–target stream_selector Specifies an alternate deliver target
stream in the same or a different
project

deliver

--baseline baseline-selector
...

Specifies a list of baselines to deliver

–baselines Displays differences in terms of
member baselines for the named
composite baselines

diffbl

–nrecurse For composite baselines, displays
differences between the named
baselines themselves and not
between their members

diffcr –follow Lists link targets only

lsactivity –contrib Displays contributing activities
delivered in an integration activity

lsbl –cview Lists baselines in the stream attached
to the current view

lsvob –family vob-family-uuid Lists the VOB with the specified
VOB family UUID

Changes to ClearCase Commands 39



Command New Option/Argument Use

–adepends_on Adds dependency references to
baselines in its member components

-ddepends_on Drops dependency references to
baselines in its member components

-nact Makes a baseline only in the specified
component

mkbl

-component component-

selector

Specifies the component whose
dependency relationship you wish
to change. When used with -import,
specifies the component that contains
the label type

mkcomp -nroot Specifies the non-root directory for
components which only contain
baselines

mklabel -follow Label the targets of VOB symbolic
links

-policy policy-keyword [,...] Enables the specified policy

-npolicy policy-keyword [,...] Disables the specified policy

mkproject

-spolicy policy-keyword [,...] Allows the specified policy to be
enabled or disabled by individual
streams in the project

-target stream-selector Sets the default deliver target for an
integration stream only

-policy policy-keyword [,...] Enables the specified policy

-npolicy policy-keyword [,...] Disables the specified policy

mkstream

-in stream-selector Selects the parent stream of the
stream to be created

rebase -stream stream-selector Specifies the stream to be rebased
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Command New Option/Argument Use

-abort (merge only) Cancels the command
rather than engage in a user
interaction; a merge takes place only
if it is completely automatic.

-blank_ignore (compare only) Leading and trailing
whitespace is ignored, and internal
runs of whitespace are treated as a
single space.

–qall (merge only) Turns off automatic
merging.

–query (merge only) Turns off automatic
merging for non-trivial merges.

xmldiffmrg

–visible_blank Displays blank spaces as visible
characters (character to be displayed
can be set using the xmldiffmrg GUI).

Obsolete Options and Arguments

The -title title option/argument pair, previously used by the ClearCase commands
chfolder, chproject, chstream, mkfolder, mkproject, and mkstream, is obsolete at this
release of the product.

In addition, the –generate old-object-selector option to the rename command is also
obsolete.

Obsolete Commands

The clearexport_ffile command is obsolete; use clearfsimport instead.

Other Changes

Redefinition of element types (mkeltype -replace) is no longer allowed in replicated
VOBs.

Changes to Documentation

The following major changes have been made to the documentation:
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Integration of UNIX and Windows material in a single Command Reference.

There is significant reorganization of material in the Administrator’s Guide, Building
Software, and the Command Reference.

Unification of UNIX and Windows Command Reference

The ClearCase Command Reference is now published in a single edition for both UNIX
and Windows. At the beginning of each reference page are tables that show the
platforms and ClearCase Product Family products to which the interface described
applies.

Changes to Release Notes

The first chapter of the Release Notes for Rational ClearCase and ClearCase MultiSite
(this document) has been reorganized. All the material related to basic hardware
and software requirements for installing and running the products has been moved
to a single section titled Hardware and Software Requirements in the READ_ME_FIRST
chapter, to make it easier for customers to prepare for installation of new versions of
the products.

Manual Reorganization

Large sections of material in the Command Reference have been moved to other
manuals, and some material from Building Software has been moved to the Command
Reference.

Certain build-related information that was formerly published in Building Software
is now published in the following reference pages:

clearmake.options
makefile_aix
makefile_ccase
makefile_gnu
makefile_pmake
makefile_smake
makefile_sun

Some reference pages that do not describe any user interface—but rather ClearCase
internals or concepts—have been removed from the Command Reference and the
information has been incorporated into other titles.

In particular, information from the following obsolete reference pages is now
published in the Administrator’s Guide for Rational ClearCase:

abe
admin_server
albd_server
db_server
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db_dumper/db_loader
errorlogs_ccase
license.db
lockmgr
registry_ccase
type_object
view
view_server
vob
vob_server
vobrpc_server

Information from the following obsolete reference pages is now published in
Building Software:

bldhost

bldserver.control

config_record

derived_object

A new reference page, intro, provides a broad orientation by organizing all
ClearCase Product Family commands into various lists.

A new reference page, xmldiffmrg, describes the use of the XMLDiff/Merge tool, in
particular its command-line options and arguments.

Changes to Command Reference

In previous releases, restrictions for commands were in a section called PERMISSIONS

AND LOCKS. In this release, the section is named RESTRICTIONS. The section that was
previously named Permissions Checking is now called Identities. There is a new section
named Mastership, which describes any restrictions applied when the command is
run in a replicated VOB.

The msdostext_mode reference page now describes the options –r and –f. The –r
option resets the line counters for elements of type text_file that have been changed
to a binary type, and the –f option forces a recalculation of the line count of all VOB
objects of type text_file.
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What’s New in
MultiSite 3

This chapter summarizes new and changed features in this release of Rational
ClearCase MultiSite.

For more information about the commands described in this chapter, see the reference
pages in the Administrator’s Guide for Rational ClearCase MultiSite. For information
about the feature level requirements for using these features, see PVOB Feature Level
Requirements in Chapter 4.

Requests for Mastership of Branch Types Now Supported

In this release, the reqmaster command and the Properties Browser support requests
for mastership of branch types. For more information, see the reqmaster reference
page, the MultiSite online help, and the Implementing Requests for Mastership chapter in
the Administrator’s Guide for Rational ClearCase MultiSite.

New Tool to Check Epoch Numbers

The epoch_watchdog script checks whether a VOB replica’s epoch numbers have rolled
back without a restorereplica command being run. This script is intended to be run
regularly by the ClearCase scheduler. For more information, see the epoch_watchdog
reference page in the Administrator’s Guide for Rational ClearCase MultiSite.

MultiSite installation does not create a task or job for the script. For information on
setting up a scheduled job to run epoch_watchdog, see the scheduler reference page
in Command Reference and the scheduler information in the Administrator’s Guide
for Rational ClearCase.

Note: A previous version of this script was shipped as part of a patch. The Version
2002.05.00 script no longer supports the -notify option. To set up notification, use the
notification option in the ClearCase scheduler.
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New Object Selector for describe Command

The describe command now accepts a replica-uuid-selector argument, which you
can use to display the properties of a replica by specifing its UUID. Specify
replica-uuid-selector in the following form:

oid:replica-uuid@replicauuid:replica-uuid

The replica you specify must be at your current site. If the replica is located at a
remote site, the command does not return any output.

The description of this object selector in the describe reference page incorrectly uses
replica-oid; it should use replica-uuid.

New Option for lsvob Command

The lsvob command has a new option, –family vob-family-uuid. This option prints
information about the VOB with the specified VOB family UUID.

Properties Browser Displays Replica Connectivity

When you display the properties of a sibling replica, the General tab indicates whether
the replica has IP connectivity to the current replica. You can change this property by
setting or clearing the check box or by using the chreplica command.

Changes to Commands

Table 13 lists new options and arguments in this release. For more information, see
the reference page for the command.

Table 13 New Options and Arguments in MultiSite Version 2002.05.00

Command
New Option or
Argument

Use

chmaster –stream [ –override ] Changes mastership of a UCM stream
and its associated objects.

chreplica –isconnected
–nconnected

Indicates whether a sibling replica has
IP connectivity to the local replica.

describe replica-uuid-selector Describes a replica when you specify
the replica’s UUID.
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Command
New Option or
Argument

Use

lsvob (cleartool
command)

–family vob-family-
uuid

Lists the VOB with the specified VOB
family UUID.

multitool –status Returns status of multitool
subcommands when you enter
them in multitool interactive mode.

reqmaster branch-type-selector Requests mastership of a branch type.

Changes to Command Syntax

chmaster

The –force option has been changed to –obsolete_replica.

mkreplica

The –vob option for mkreplica –export is now obsolete. This option was replaced by the
replica-selector argument in Release 3.0.

The —tape option has been removed.

reqmaster

The –instances option is now optional.

restorereplica

The –completed option has been changed to –override.

syncreplica

The –tape option has been removed.

Changes to Command Output

The following sections describe the changes to command output in this release.

describe

The output for describe replica: includes the connectivity property.
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multitool

The output for –version and –VerAll displays the version string in a different format.
The new format uses a version string like the following:
2002.05.00

restorereplica

Additional warning text has been added to the output from restorereplica —override.

Changes to MultiSite Documentation

In the MultiSite reference pages, the section named Permissions Checking is now
named Identities.

The following chapters contain significant new information:

The chapter Introduction to MultiSite contains a summary of mastership restrictions
for ClearCase operations.

The chapter Planning a MultiSite Implementation contains information about
different kinds of synchronization patterns.

The chapter Synchronizing Replicas contains information about synchronizing more
efficiently by using the chepoch –actual command.
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Restrictions and
Guidelines for Using
ClearCase

4

This chapter provides restrictions on and guidelines for using Rational ClearCase
Version 2002.05.00 software that are considered noteworthy. These are not considered
defects because the behavior reported is not expected to change in a future release
of the product.

Guidelines for Using UCM

The following sections provide guidelines for using UCM.

PVOB Feature Level Requirements

This version of ClearCase introduces a new feature level, Feature Level 3 (FL3).
To support all of the new UCM functionality provided with the new release, a
PVOB must be upgraded to the new feature level. Until a 2002.05.00 PVOB has been
upgraded to FL3, it will support ClearCase Release 4.x clients as well as Version
2002.05.00 clients, but without providing support for all the new UCM functionality
delivered with the new release.

Specifically, the following new features are not supported, even on 2002.05.00 clients
accessing 2002.05.00 servers, until the feature level of the associated PVOB has been
raised to FL3:

Creation of baseline dependencies (composite baselines)

Creation of components without root directories

Using composite baselines to configure a stream

Creation of sub-VOB components

Creation of nested streams

Support for relationships between a single PVOB and multiple ClearQuest user
databases

Installing this software on a PVOB server that is running a previous release of
ClearCase does not automatically change the PVOB’s feature level; you must raise the
feature level manually. Before raising the feature level, all ClearCase clients accessing
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that PVOB must be upgraded to Version 2002.05.00. ClearCase UCM operations will
fail on clients that run previous versions of ClearCase if they try to access a PVOB
whose feature level has been upgraded to FL3.

When Setting Up a Project, Make Components Read-Only Initially

This release of ClearCase supports the ability to change a stream’s configuration from
one using a modifiable component to one using a nonmodifiable one. However, we
generally recommend that components initially be specified to be nonmodifiable
when creating a new project. After verifying that the project builds and tests correctly,
update the project policies to allow modifications to any or all components.

Check In to Non-UCM VOB from UCM View if ClearQuest Is Enabled

If, in a UCM view, you check out or check in an element from a VOB that is not a
UCM component, you should not have to select an activity, because that operation
is not captured in a change set.

However, if you are in a view that is in a ClearQuest-enabled project, both the Check

Out dialog box and the Check In dialog box force you to select an activity even though
one is not really required.

Workaround: Select the activity; it will be ignored.

Using UCM in a MultiSite Environment

When you join a project in which the integration stream is not mastered by your
current replica, you can create a development stream and view, but not an integration
view. The Join Project Wizard displays a message that you will not be able to create
an integration view; but when you click Finish, the wizard attempts to create the
integration view and fails. If creation of the development view and stream succeeded,
you can ignore the error.

Notes on Using the UCM-ClearQuest Integration

The UCM process in ClearCase is enhanced for sites that have installed Rational
ClearQuest by a very tight integration between the activity management provided
by UCM and the change request management provided by ClearQuest. Use the
following guidelines with the UCM-ClearQuest integration.

Transitioning a ClearQuest-Enabled Activity After Delivery Using
the CLI

If the Do ClearQuest action after delivery policy is enabled on a UCM project, delivery
of a ClearQuest-enabled UCM activity using the command-line interface (CLI) may
result in an attempt to transition the activity to a Complete state type.
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If the activity record has a field that must be filled in before it can transition to the
Complete state, the program displays an error. An example is the Defect record
type in the default UnifiedChangeManagement schema, whose Resolution field must
be nonempty before it can be resolved.

Workaround: Modify the UCU_CQActAfterDeliver global script to include code similar
to that below, which fills in the Resolution field when the activity is delivered.

REM Add complete resolution code
REM Defect record type requires Resolution field to be non-empty

’Get hook’s session context
Set Session = GetSession()

’Get the entity
Set entity = Session.GetEntity(entity_type,entity_id)

REM If record type is "Defect"
... If(entity.GetEntityDefName = "Defect") Then
REM If Resolution field is empty
... If(entity.GetFieldValue("Resolution").GetValue = "") Then
REM Fill in required field

session.EditEntity entity, "modify"
Call entity.SetFieldValue("Resolution", "Fixed")
msg = entity.Validate

REM Remember to do some action if validate fails
entity.Commit
End If End If

For information on editing entities, see the ClearQuest API documentation .

Schema Requires Submitted State

If you are applying the UCM package to a custom ClearQuest schema (as opposed to
using the out-of-the-box Unified Change Management schema), be aware that this
package depends on the existence of a state whose name is Submitted. If your custom
schema does not include a Submitted state, you can apply the package to your schema
by using one of the following methods:

Before applying the package, temporarily rename the state that is the target of the
Submit action to Submitted. After applying the UCM package, you may rename
it to its original name.

Create a dummy state called Submitted, and assign its state type to Complete. If you
do this, you must also create a dummy action whose target is the Submitted state.
After applying the UCM package, you may delete the dummy state and action.

ClearQuest Script Error Text Not Reported

Using the UCM-ClearQuest integration, you can customize the Check Before Deliver
ClearQuest Visual Basic policy script. However, if the script as customized contains
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an error that causes the Visual Basic interpreter to display an error exception, the
Deliver dialog box reports this error like this:

An error occurred during the deliver.
Unexpected error in deliver.

It does not report the actual error exception text, which would enable the user to
diagnose the problem script.

Workaround: To see the error exception text, use the cleartool deliver command.

Changes to UCM CustomQuery1 Do Not Appear in Dialog Box

When using the UCM-ClearQuest integration, the list of records displayed in the list
on the Add To Source, Check Out, and Check In dialog boxes is generated by running the
UCMCustomQuery1 query, which can be customized. (To see the effect of your changes,
you must click File>Save to save the query edits.)

However, if you copied the Public Queries UCMCustomQuery1 query to your Personal

Queries folder and edited it there, the changes are not immediately visible. To see your
changes, you must stop the integration server process.

On Windows NT or Windows 2000

1 Start the Task Manager and click the Processes tab.

2 From the list, select CQINTS~2.EXE or CQINTSVR11.EXE.

3 Click End Process.

On Windows 98 and Windows Me

1 Press CTRL+ALT+DELETE.

2 From the list, select CQINTSVR11.

3 Click End Task.

After stopping the process on your computer, open the dialog box again. Further
edits to /PersonalQueries/UCMCustomQuery1 appear without your having to shut down
the process again.

ClearCase Client Loops on Windows 98 Systems with ClearQuest

If ClearQuest software is incorrectly configured (for example, connected to the wrong
database), ClearCase operations such as checking an element out will fail, because
the ClearQuest record corresponding to the UCM activity cannot be located. On
Windows 98 systems, this failure can cause the dialog box to be “stuck” so that clicking
Cancel does not remove it. To work around the failure, do one of the following:

52 Chapter 4 - Restrictions and Guidelines for Using ClearCase



Click another window before clicking Cancel.

Press CTRL+ALT+DEL to start the Task Manager; in the Task Manager, kill the
program that is displaying the dialog box.

Cannot Import UCM-Enabled Records from ClearQuest Database

In general, you cannot import UCM-enabled records from a ClearQuest database;
ClearCase cannot guarantee that UCM information that references an arbitrary
ClearQuest database is correct. However, this restriction does not prevent data
recovery in the event of a data loss. Records may be successfully imported into a
ClearQuest database if all the following conditions are true:

The records have been backed up from that database.

The name of the database has not changed.

The ClearCase UCM information in the record is still valid.

Cannot Delete a Project Record in ClearQuest

If you are working with a UCM project that is linked to a ClearQuest user database
and attempt to delete the project record, you get a run-time error. You cannot
delete the record or undo the CommitAction hook. The workaround is to use the
squid_patch utility to force the ucm_vob_object field of the orphaned project to 0.

Changing Name of ClearQuest Record Type Causes Error

In the UCM-ClearQuest integration, if you change the name of the ClearQuest record
type after activities have been linked to ClearQuest records of that record type, the
integration displays an error message when you try to set one of those activities in
a view. To change the name of a record type, do so before any activities are linked
to records of that record type.

Opening Multiple Nested ClearQuest Forms May Cause Crash

The ClearQuest integration for UCM does not prevent you from doing the following:
open a ClearQuest form; go to the form’s UnifiedChangeManagement page; use
the shortcut menu in the change set to open a ClearCase dialog box; and then select
Activity Properties, which opens a second ClearQuest form.

However, if you follow the above steps, the second ClearQuest form does not function
correctly. In particular:

The Apply, Revert, and Cancel buttons on the form have no text.

If you attempt to go to the form’s UnifiedChangeManagement page, then dismiss
the form, you get this error:
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Unable to load message ID 14090 from resources

ClearCase then crashes.

Therefore, we recommend that you not use the above procedure to open a second
ClearQuest form.

Must Rerun ClearQuest Maintenance Tool If ClearQuest is
Reinstalled

If you upgrade ClearQuest, the registry settings that keep track of the current database
are removed. You must run the Rational ClearQuest Maintenance Tool to reestablish
the default database for the computer.

Availability of Check Mastership Policy

The ClearQuest page of the UCM project Properties Browser has a check box for
the policy Check mastership before deliver. This is supported with the UCM 3.0 and
UCM 4.0 package revisions. If you are using the 2.0 package revision, the check box
is unavailable.

Changing a Project Name Does Not Automatically Update
ClearQuest

If information in ClearQuest records is changed from a ClearCase application, such as
cleartool or the UCM Project Explorer, the ClearQuest display may not always reflect the
actual contents of the database. To refresh the display, close and re-open the database
from the File menu.

When Running Integration, Certain Operations Do Not Require
ClearCase Installed

The following ClearQuest operations do not require ClearCase to be installed on the
user’s system when working with the ClearCase/ClearQuest integration:

Submiting new CQ records (Defect, BaseCMActivity, or UCM_Project).

Modifying an activity record if its headline field has not been changed.

Modifying a UCM_Project record if its name field has not been changed.

Rebasing a Stream

A stream can be rebased to a baseline that meets the following criteria:.
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The baseline is not from the stream that is being rebased.

The baseline is labeled. Baselines created by deliver operations are not labeled by
default. For information about how to change a baseline’s labeling status, see
the chbl reference page.

Additional rules apply to integration streams and development streams in selecting a
baseline

An integration stream can be rebased only to a baseline created in another project
or to an imported or initial baseline of that project.

A development stream can be rebased to a baseline that meets one of the following
criteria:

The baseline was created in its parent stream.

The baseline is in its parent stream’s foundation

The baseline was created in a stream other than its parent stream, and is
contained in its parent stream. A baseline is contained in another baseline if all
changes in the first baseline are included in the second baseline.

Rebase is typically used to advance a stream’s configuration; that is, to replace
its current foundation baselines with more recent ones. However, under certain
conditions, rebase can be used to revert a baseline, and to add or drop a component in
a stream’s configuration. It can also switch to a baseline that is neither an ancestor nor
a descendant of the current foundation. The rules explained above are general rules
for all rebase operations. You need to satisfy only the general rules when adding a
component to a stream. When you advance, revert, drop or switch a baseline, you
need to satisfy the general rules and some additional ones.

To advance a stream’s configuration, the new baseline must contain the current
foundation baseline.

To revert or drop a baseline for a component in a stream, one of the following
conditions must be met:

The component is nonmodifiable.

The component is modifiable but has not been modified in the stream, and the
component is not in the configuration of any child streams.

To switch to a baseline that is neither an ancestor nor a descendant of the current
foundation, one of the following conditions must be met:
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The component is nonmodifiable.

The component is modifiable but has not been modified in the stream, and the
component is not in the configuration of any child streams.

The component has been modified but the new baseline contains the current
foundation baseline, and the component is not in the configuration of any child
streams.

These rules ensure that any changes made in a stream are not lost when the
configuration changes.

Clear Recommended Baseline Setting if Baseline Is Removed

If a baseline is recommended for a stream, and then that baseline is removed, clear
the recommended baseline setting in the stream by typing the command chstream

–nrecommended. Then you can set new recommended baselines by using the command
chstream –recommended.

Attache Does Not Support UCM Commands

Attache users cannot use ClearCase UCM commands.

Delivering changes to a read-only component

Deliver cannot allow changes to a read-only component. This situation can result
from someone changing the component modifiability in your project. What actions
you take depend on whether you are doing an intraproject or an interproject deliver.

For an intraproject Deliver

If you are performing an intraproject deliver for a component that was previously
modifiable, you receive a warning message. Decide what can be delivered from your
stream. If the changes in the other components are independent of the changes in the
read-only component, move the versions from the read-only component into a new
activity. Deliver all activities in your stream except the new one.

If any of the changes in the other components are dependent on changes to the
read-only component, decide whether those versions can be separated into a new
activity. This may involve not delivering a subset of activities in your development
stream.

If there are dependencies among the versions, your stream may no longer be
deliverable to its default target. Decide whether there is a project to which you can
deliver the changes. The project integrator may have to create a new development
stream in this project and selectively findmerge the changes (findmerge -insert) from
the versions into the new stream. Deliver cannot be used.
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As a last resort for an intraproject deliver, you can remove all the versions (rmver) that
should not have been made. Also, remove all changes dependent on that component.
You must use rmver -xhlink to remove the versions from the change set. You may
need to manually recode some changes to remove the dependence on the changes to
the read-only component.

For an Interproject Deliver

If you are performing an interproject deliver, you can also receive a warning message.
The project from which you are delivering and the target project can have differences
in component modifiability at any time. You have the following choices:

Set the policies on the target stream and target project so that deliver can ignore
the changes in both the read-only component and in other components that are
dependent on the changes to the read-only component.

Isolate the changes in the read-only component and changes in other components
that are dependent on the changes to the read-only component. Deliver only the
activities that contain changes to modifiable components.

Recommending a Baseline

You can recommend a baseline for a stream if the baseline is from the stream or the
stream’s foundation.

For a baseline not from the stream or the stream’s foundation, the following rules
apply:

The baseline must be from the same project as the stream.

The baseline must be contained in the stream, which means the baseline has been
delivered to the stream, or the stream has rebased to the baseline or one of its
descendents.

The baseline must contain the current recommended baseline, which means it
must be a descendent of the current recommended baseline.

You are not required to recommend a baseline for every component in the stream’s
configuration.

You can clear the list of recommended baselines. Note that doing this step alone will
cause problems when existing development streams rebase to the recommended
baselines. The rebase operation will attempt to drop all baselines in the development
streams’ configuration. This operation will probably fail or produce errors and
therefore not desirable.

You can choose to reset the recommended baselines to baselines from the stream or
the stream’s foundation with or without clearing the recommended list. This allows
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the stream to return to a known correct state after being changed inadvertently to a
bad list.

Delivering Selected Activities to a Non-default Target

Delivering selected activities to a non-default target is subject to the following
restrictions:

If the full set of activities in the stream violates one of the policy settings, you will
not be allowed to proceed with the selected activity delivery, even if the selected
activities would not violate the policies.

If the full set of activities in the stream contains changes from a foundation
baseline, you will not be allowed to deliver selected activities from this stream.
This is regardless of the deliver policy settings.

If the set of activities you want to deliver contain versions in components that are
not visible in the target stream or are not modifiable by the target stream, you will
not be allowed to deliver the set of activities. Delivering an activity requires that
you deliver all versions in all components in the change set. You can move the
versions of the missing or non-modifiable components into another activity.

Remote Deliver May Fail if Remote Site Has Not Synchronized

It is possible for a remote deliver to include changes to a component when the
component is non-modifiable in the project. This only happens when the remote site
has not synchronized with the local site, and does not know that the component
has been made non-modifiable. When the integrator attempts to resume the remote
deliver, a check is made to ensure that no versions in non-modifiable components
will be changed. If there are such versions in the deliver, the operation fails and the
user has to cancel the deliver.

Notes on Using the Base ClearCase-ClearQuest Integration

This section provides guidelines for using base ClearCase and ClearQuest together.

Support Policy on Modifying Perl Trigger Source Code

In this release, the integration includes a new trigger, which runs on Windows and
UNIX platforms. The release includes the source code, in the form of Perl scripts,
that the trigger uses. The Perl scripts include extensive comments that describe the
purpose of their classes. For additional source code documentation, including an
architectural overview and formatted class documentation, contact Rational Customer
Support. However, Rational Customer Support cannot and will not support changes
that you make to this source code.
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Using ClearQuest with Long Version-Extended Pathnames

The base ClearCase-ClearQuest integration creates a ClearCase tab on your ClearQuest
screen. On this tab, if you right-click CC Change Set Objects and then select View Details,
the program displays data about a VOB element. If the version-extended pathname is
too long to fit in the dialog box, it cannot be viewed in its entirety, because the form
does not support horizontal scrolling by default. You may want to modify the form
using the following procedure:

1 In ClearQuest Designer, check out the ClearQuest schema you are using.

2 Click Record Types-Stateless>cc_vob_object>Forms>cc_vob_object.

3 Select each text box and double its height.

4 Right-click a text box and click Properties.

5 Click the Extended tab.

6 Select the Horizontal Scroll Bar check box.

7 Repeat Steps 3 through-6 with the other text box fields.

8 Check in the schema.

9 Click Database>Upgrade Database to finish the changes.

If you wanted only the horizontal scrollbase on the name, do the following instead:

In Step 3, select the Name text box and double its height.

In Step 4, right-click the name text box and click Properties.

Ignore Step 7, which asks you to repeat the instructions.

Guidelines on Using the ClearCase Web Interface

The following restrictions and guidelines apply to using the ClearCase Web Interface.

Restrictions on the Web Interface in a UCM Environment

If you are using the Web interface in a UCM environment, you cannot use the Web
interface to work effectively in projects enabled for ClearQuest. You can view
such projects, but you cannot perform any integration operations through the Web
interface; also, you cannot use the interface as a suitable client in a UCM project
enabled for ClearQuest.

Interactive Triggers Fail When Accessed Through Web Interface

The ClearCase Web interface supports noninteractive triggers. Interactive triggers,
such as those that attempt to read input or create a window, fail.

Guidelines on Using the ClearCase Web Interface 59



If a trigger attempts to read input using clearprompt, the ClearCase Web interface
prints this error:

clearprompt is not supported in the Web interface

If a trigger attempts to read directly from standard input, it receives an error, because
standard input does not specify a valid file descriptor.

In addition, any trigger failure in the Web interface context displays this error message:

Interactive triggers are not supported in the Web interface. If the

trigger was interactive, it may have failed for that reason.

Trigger script writers can detect whether a trigger is running in the Web interface
context by checking for the environment variable ATRIA_WEB_GUI. It is set to 1 if you
are running in the Web interface context.

Note that the base ClearCase-ClearQuest integration is dependent on the operation
of interactive triggers; for this reason, the ClearCase Web interface is not a viable
interface for using that integration.

Restrictions on Comparison of Some Element Types

The Web interface does not support graphical (tree view) comparison of XML file
elements; the Web Compare tool displays a text-based comparison for elements of
type xml. When comparing HTML files, the program displays the differences in
the Compare screen as text, but includes hyperlinks to display the individual files
appropriately formatted using your default browser.

In addition, because the Compare tool in the Web interface handles only text files, it
does not support comparison of Rational Rose or Microsoft Word files.

Error When Checking in Large File from Windows NT Web Client

Windows NT 4.0 sends very large amounts of information to a Web server. This
behavior causes the ClearCase Web interface to fail when attempting to check in very
large files (on the order of several megabytes). This problem appears to be fixed
in Windows 2000.

Host Name Resolution Must Be Enabled on Web Interface Clients

The Java program used in the Web interface attempts to connect to the Web server
to transfer files. Web browsers only allow Java programs to open connections to the
server from which the programs were downloaded.

To enforce this rule, the Web browser on the Web interface client must be able to
resolve the Web server’s host name to an IP address. If you use a host name in a URL
that cannot be resolved by the client host, the Java program cannot connect to the
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server. In this case, Web-interface file-transfer operations such as checkout, checkin,
and download fail.

If the Web server is being accessed through a firewall by means of a proxy server, the
proxy server being used must support DNS lookup outside the firewall.

ClearCase Web Interface Problem in Overriding Primary Group

When the ClearCase Web server on Windows logs on to a client, it sets the primary
group to the designated primary group in the client user’s domain account. In Release
4.0, you could not override this group setting. As a result, sites that use domain
mapping to allow user accounts in multiple domains to share VOBs could not access
those VOBs through the ClearCase Web interface.

Workaround: Specify a configuration variable in the ccweb.conf file, and add a value
to the registry that enables domain mapping.

Adding the Variable to the ccweb.conf file

To enable a single Web server to support one primary group override, add the
–primary_group variable with a groupname value to the ccweb.conf file. The allowable
values for groupname are the same as for the CLEARCASE_PRIMARY_GROUP
environment variable. The ccweb.conf file must be located in ccase-home-dir\var\config.
If you need more than one primary group override, configure additional Web servers.

Setting the Registry

Typically, when domain mapping is used to allow users from multiple domains to
access the same VOB, each user must create the DomainMappingEnabled value (set to 1)
in the HKEY_CURRENT_USER\Software\Atria\ClearCase\CurrentVersion registry key.

To enable domain mapping for a Web server, create the DomainMappingEnabled value
in the HKEY_LOCAL_MACHINES\Software\Atria\ClearCase\CurrentVersion key on the Web
server machine. The value must be of type DWORD and set to 1.

If you log on directly to the computer instead of logging on through the Web interface,
user values for DomainMappingEnabled override the machine value.

Problems With Toolbar Menus When Using Netscape

Toolbar popup menus don’t close properly when running the Web interface using
Netscape Navigator. Rather than closing automatically when the mouse pointer is
moved out of the menu location, they close only when you must reselect the menu
button.
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Conflict Between Netscape and Earlier Versions of Exceed X Server
Windows

If you access the ClearCase Web interface using a Netscape browser on a Windows
system and also use a version of the Exceed X Windows Server earlier than 6.0, do
not let the Netscape window lose its focus to an Exceed window. Doing so causes the
Netscape window to restart any Java applets it is currently running, which interferes
with file transfer operations, for example, download, checkout, or checkin.

Neither Internet Explorer nor Version 6.0 of the Exceed X Server has this problem.

Required Internet Explorer Settings

In order to run the Web interface successfully, the Internet Explorer setting ’Check
for newer versions of stored page’ should be set to the value "Automatically." To
access this setting, click on Internet Explorer ->Tools->Internet Options->Temporary Internet

Files->Settings->Check for newer versions of stored page.

ClearCase Web Interfacer Does Not Work with iPlanet Web Server if
ClearCase is Installed in ’Program Files’ Directory

The Windows version of the iPlanet Web server does not allow a pathname for an
"Additional Document Directory" to contain spaces. Since the ClearCase Web interface
requires configuration as an "Additional Document Directory" mapping to the "web"
directory under the ClearCase installation directory, ClearCase cannot be installed
in a location which contains spaces (for example the ’Program Files’ directory) if the
iPlanet web server is expected to provide the ClearCase Web interface.

Web Views Can Only Be Accessed Using the Web Interface

Web views can only be accessed via the Web interface; they cannot be used with
native ClearCase interfaces (for example ClearCase Explorer or cleartool). Various
native GUIs may allow selection of a Web view (for example as a deliver target),
but any attempt to access a Web view using a native ClearCase interfaces will result
in a warning or error message.

Preparing Old Web Views to Run with ClearCase 2002.05.00

Rational ClearCase 2002.05.00 introduces a new ClearCase Web interface. This
interface is not compatible with Web views created by previous ClearCase Web
interface clients. If you want to re-use existing Web views, we recommend that you
clean them up before you upgrade the ClearCase Web server host to ClearCase 5.0.

Use the following procedure:
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1 Check in all checked out files and directories, or cancel the checkouts.

2 Make a note of the files and directories you have loaded into the view. You can
use this information to configure the view to load these objects after the Web
server host has been upgraded.

3 Unless the view contains important view-private files or directories (or hijacked
files that you cannot convert to checkouts and then check in), delete all files and
directories under the Web view root directory, but not the root directory itself.

Guidelines on Using the XML Diff Merge Tool

The tool presents some problems with scrolling:

Windows restricts the height of a window to 32,767 pixels. This may not be enough
to display the contents of large XML files. If this maximum size is exceeded, XML
Diff Merge compensates for this restriction by reporting the number of lines that
are not visible. This line count is displayed in the title bar of any affected tree view
pane. The size (height) of the tree control window may be reduced by collapsing
tree nodes. When nodes are collapsed or expanded, the count of lines not visible is
updated. When the entire file is visible, the title bar indicator is removed.

The operations "collapse branch", "collapse level" and "collapse attributes" can be
used to collapse many nodes in the tree at once. For navigating differences in an
especially large file, we recommend that you collapse the tree entirely by selecting
"collapse branch" on the root element, and then use the difference navigation
buttons to expose the individual differences.

If a tree control is scrolled horizontally, and then the control is widened such that
the horizontal scroll bar is removed (the control is now wide enough to display the
entire horizontal contents), the tree remains scrolled horizontally. Its scroll position
should be "pulled back" to the left (zero).

Workaround: Scroll the control to the left (zero) before resizing it.

When an attribute name node is collapsed, it also displays the attribute value in
the form ’name = "value"’. The length of this "summary text" should be measured
when computing horizontal scroll extents. Currently, "name" and "value" are
measured separately, and this may cause the horizontal scroll extent to be too
small if the ’name = "value"’ line is the longest line.

Workaround: The right scrollbar button always scrolls, so any horizontal extent
can be made visible.

When the display is horizontally scrolled, the background rectangle of some
attribute name nodes may not be computed correctly, causing a certain amount of
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the default selection rectangle to "peek through". This default rectangle will be
colored in the user’s default selection background color.

Workaround: Make the tree control wider, rather that use horizontal scrolling, and
the background rectangle will be displayed correctly.

Using Internet Information Server to Serve Web Pages from
a VOB

If you intend to use Internet Information Server (IIS) to serve Web pages within a view
and VOB, you must configure IIS to log on as a Windows NT domain user that has
access to that view and VOB data, use this procedure:

1 Make sure that the views and VOBs serving the Web pages use NTFS, not FAT, for
storage.

2 Start the Services Control Panel program.

3 Double-click World Wide Web Publishing Service; a Service dialog box appears.

4 Click Manual startup type, and then click OK.

5 Create a domain user who is a member of the same primary group as ClearCase
users.

6 Make the user the Anonymous Login user for IIS:

a Click Start>Programs>Microsoft Peer Web Services>Internet Service Manager.

b Start the WWW service, if necessary.

c Double-click Service to display its property sheet.

d Enter the user name in the format domain\user, for example, rational\webclient.

7 Start the view or views from which you want to publish and mount the VOBs
you need.

8 Start the IIS service.

9 On the Directories tab, set aliases to directories in the VOB or VOBs.

IIS and ClearCase should now work together on the same computer.

Note: Whenever you restart your computer, always start views and mount VOBs
before you start the IIS service.
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Third-Party Integration Guidelines for ClearCase Version
2002.05.00

ClearCase contains support for Visual Studio 6.0 (including Visual InterDev) tools
that use the Microsoft Common Source Code Control Interface (SCC) integration. It
also contains support for Microsoft Word, Microsoft FrontPage, Microsoft Office
2000, and Sybase PowerBuilder. This section contains guidelines on using ClearCase
with integrated products.

Using ClearCase with Microsoft Web Tools

ClearCase is integrated to work with FrontPage 98, FrontPage 2000, Visual InterDev,
Microsoft’s Save to Web Office 2000 functionality (Word, Excel, PowerPoint), and
Microsoft Internet Explorer 5 (IE5) Web Folders.

When using ClearCase with these programs and tools, follow the guidelines below:

If you have been running the FrontPage integration in local mode with ClearCase
Release 4.0, you must upgrade to Version 2002.05.00:

1 Install Version 2002.05.00 on your client.

2 Start the Web Authoring Integration Configuration Wizard. To do so, click
Start>Programs>Rational ClearCase Administration>Integrations>Web Authoring

Integration Configuration.

3 Select Local Mode Configuration.

Users/Groups that are granted Front Page Server Extensions (FPSE) Author rights
must match the identities of the Users/Groups with write access to the Web content
VOB. In particular, granting Author rights to Everyone or to the IIS Anonymous user
is not supported.

The ClearCase/FrontPage Web server maintains a cache of source control
information, including checkout status, user, time, and version. This cache is not
updated when source control operations are performed using ClearCase tools
such as the Version Tree Browser, or cleartool, rather than from within a Microsoft
Web program like FrontPage. For this reason, it is recommended that all source
control operations be performed from within the appropriate Microsoft Web tool.
In the integration with FrontPage 2000, the ClearCase commands Update View and
Refresh Source Control Status and the iisfix.bat script can be used to resynchronize
the cached source control information.

Use of FrontPage borders and themes can cause many extra source control
operations to be performed, slowing integration performance.
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As described in the online help for the integration, users access files using a shared
snapshot view created for the ClearCase/Web tools integration on the ClearCase
Web server; the view tag of this view is fp_hostname_default-web-alias-path. If a Web
uses the IIS Challenge/Response authentication method, this view must be located
on the IIS Web server, and the VOB must either be on the same IIS Web server or
on a UNIX VOB server configured to use CCFS.

If you are attempting to import an existing Web with FrontPage Server Extensions
installed into a VOB, you must remove all vti* directories from the Web before
using clearexport_ffile/clearimport.

Using ClearCase with Visual InterDev

The integration of ClearCase Version 2002.05.00 and Visual InterDev may cause
corruption and data loss. The problem occurs when user A checks out a file and
then user B checks out the same file; user A is permitted to check in before user B.
When attempting to check in the file, user A receives an error message and the file
becomes corrupt.

There are three ways to deal with multiple-checkout problems in Visual InterDev:

Add all users who may potentially check out the same files at the same time to
the ClearCase domain group. This gives users permission to check in any files
checked out by another user.

Enable simulated checkouts for all files in the Web content VOB. The actual
checkout occurs at checkin. This deferral allows multiple users to successfully
check out the same file at the same time. However, these checkouts appear only in
the Visual InterDev GUI. To enable simulated checkouts, change the value of the
registry key HKEY_LOCAL_MACHINE\Software\Atria\ClearCase\CurrentVersion\SSAPI\
Performance\SystemFiles from the default value to the string value *.

Disable the multiple-checkout functionality. To do so, you must turn on a new
registry key. After this new registry key is set, Visual InterDev enforces a single
checkout model. To disable multiple checkout functionality, add the new registry
key as a DWORD value:

HKEY_LOCAL_MACHINE\Software\Atria\ClearCase\CurrentVersion\SSAPI\
FailCOIfAlreadyCO

If the value is set to 1, a checkout fails if the object is already checked out.

Using ClearCase with Microsoft Visual Studio

To use the ClearCase integration with Visual Studio, users must do one of the
following:
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Install ClearCase after installing Visual Studio.

When installing Visual Studio, choose the option to do a custom install. Then clear
the appropriate options so that you do not:

Install Visual Source Safe

Make Visual Source Safe the source code control program

Using ClearCase with Microsoft Visual C++

ClearCase uses the Microsoft Common Source Code Control (SCC) interface to
integrate with the Microsoft Visual C++ available through Microsoft Visual Studio.
ClearCase has support for Visual C++ versions 5.0 and 6.0. You can switch between
SCC-support versions 5.0 and 6.0, but only one version can be enabled at a time.

The ClearCase SCC interface for Visual C++ 6.0 also supports Visual Basic 6.0, Visual
J++ 1.1, and Visual InterDev 6.0.

Using ClearCase with Visual Studio components requires no special configuration
on the part of the user. For more information, see the information on Developing
Software in online help.

Issues with Visual C++ Addin Toolbaron Windows 2000

If you install Windows 2000 on a computer that currently runs Windows NT with the
Visual Studio integration and then reinstall ClearCase, the Visual C++ 6.0 Add-in
toolbar for the ClearCase integration contains five Version Tree buttons. All five
buttons start the Version Tree Browser. To correct the problem, remove the ClearCase
toolbar and then re-add it:

1 Click Tools>Customize and click the Add-Ins tab.

2 Clear the ClearCase check box and close the dialog box.

3 Click Tools>Customize and click the Add-Ins tab.

4 Select ClearCase on the list and close the dialog box.

Changing ClearCase Properties for Visual C++ Projects

If you have existing Visual C++ projects in ClearCase and want to set the MVFS to
be case-preserving or if you want to use snapshot views on those projects, you must
manually rename the elements in the VOB that correspond to Visual C++ project file
names to have the case-correct names. For example:

cleartool checkout .
cleartool mv foobar FooBar
cleartool mv ...
...
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cleartool checkin .

New projects created in a snapshot view or in a case-preserving MVFS environment
require no such renaming to work properly.

Using ClearCase with Microsoft Visual Basic

Use the following guidelines when using the ClearCase integration with Microsoft
Visual Basic.

Disabling the IDE During Project Debugging

The Visual Basic IDE by design disables or unloads all add-ins while debugging a
project. Therefore, the ClearCase toolbar, which is an add-in, is disabled; no ClearCase
operations can be performed from the Visual Basic IDE while the debugger is running.
ClearCase operations can be performed while debugging outside the Visual Basic
IDE by using ClearCase Explorer.

Problem Checking in Identical .frm Files in Visual Basic 6.0

By default, ClearCase does not create a new version of a file that is identical to its
immediate predecessor. When you attempt to check in a .frm file that is identical to
the checked-in version, the integration does not check it in. However, if the .frm file
has an associated .frx file, the integration checks in the .frx file and any other binary
files associated with the .fm file, and the files may become out of sync. To avoid this
problem, set the option to allow identical checkins.

FRX Files Kept in Sync with FRM Files

In previous releases, if a form and a matching .frx file were created in a directory other
than the one containing the project file, Visual Basic could not track the .frx file for
source control purposes. In this release, ClearCase searches for .frx files and performs
source control operations on them to match those done on the .frm file.

FRX File Not Checked Out When Part of Visual Basic Group

In a Visual Basic version 6.0 project that is part of a Visual Basic Group, when you
check out an .frm file (with an .frx file), ClearCase does not check out the associated
.frx file automatically. This behavior may cause synchronization problems. When
working with a Visual Basic 6.0 project that is part of a Visual Basic Group, be sure
to check out both the .frm and .frx files.

Error Message When Opening Visual Basic 6.0 Project

When you open a Visual Basic 6.0 project that is checked in, the integration displays
the following error message: .
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Failed to update project location information in the host application

The integration displays this message because the Visual Basic project file is not
checked out and the project location information cannot be updated. To avoid this
message, check out the project file before you open the project.

Reopening Visual Basic 6.0 Project Fails to Update Project
Information

When you use Visual Basic 6.0, a problem can occur if a project’s source files reside in
a dynamic view that is mapped to drive M. After you reload it, Visual Basic cannot
reopen the project from the list of recent projects at the bottom of the File menu and
displays the error message reopening recent project fails to update project

information in recent project.

To work around this problem you can delete the file MSSCCPRJ.SCC which
Microsoft-creates and then add the project to source control again.

Using ClearCase with Microsoft Word

Follow the guidelines below when using the Version 2002.05.00 integration with
Microsoft Word.

Removing the Old Integration if Two ClearCase Menus Appear

If two ClearCase menus appear at Word startup, this means that the old integration
with Word 97 was not successfully removed even though the user is running Word
2000. This may occur if the location of the startup folder has changed, thus moving
the clearcase.dot template from its default location. The clearcase.dot template will
need to be deleted manually. To remove the old integration, locate the clearcase.dot
file in the Word startup directory.

1 In Word, click Tools>Options.

2 In the Options dialog box, click the File Locations tab.

3 Double-click the Startup item on the list to open the Modify Location dialog box.

4 Right-click in the large list box in the center of the dialog box (the list box may be
empty) to display the shortcut menu. Click Explore to start Windows Explorer. In
Word 2000, the startup folder is displayed in the Folder name box in the dialog box.

Windows Explorer is rooted in the Word startup folder.

To remove the old integration, remove the .dot file associated with it from your Word
startup directory, or rename the file to have a different extension.
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Word Does Not Recognize a File As Versioned if it is Opened with
the DOS "short name"

A file opened with a pathname like T:\ABISSO~1\test.doc will appear to be a
nonversioned file.

ClearCase Does Not Recognize a Versioned file if a URL Is Used
as a Pathname

If the pathname to the document that is being edited is a URL the integration does
not treat the file as an element even if it is. The integration behaves as if the file is
not in a VOB directory.

ClearCase Operations Do Not Work When Word is Embedded
Within Internet Explorer

When a Word document is displayed within Internet Explorer the pathname that is
made known to the Word integration is not useful. Therefore, it is not possible to
handle a document as a ClearCase element when editing with Word embedded in
Internet Explorer. Note also that, in this case, all ClearCase commands are enabled
and none work correctly

Under Certain Conditions, ClearCase Menus Are Disabled

All menu items are disabled if either one of two conditions exists: no document is
open or the Connected to network for ClearCase operations check box is not selected in the
ClearCase control panel applet on the Options page. This is by design. This switch is
intended to be used by applets to disable operations that would otherwise hang the
system until a time-out occurred.

Problems Working With Files Opened in Word

In general, if you rename or delete an eclipsed file, the operation is performed only on
the view-private object that is eclipsing the ClearCase element.

The exception occurs when the view-private file is being edited in Microsoft Word.
Word maintains a lock on the file, which makes it impossible for any other program to
touch or operate on it.

Workaround: Close the file in Word, or use the ClearCase integration with Word.

Word XP Launches Two Windows for Diff and Merge

When the MS Word integration is used with Word XP, the diff and merge functions
work differently from earlier versions of Word.
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When doing a comparison, two windows appear. The top-most window contains the
comparison results. Closing that window results in a prompt to save a temporary
document. You can safely answer "No". You will then have to close the window
that was behind the comparison window.

When doing a merge, two windows appear as well. The top-most window contains
the merge results. After resolving merge choices, closing that window results in
the expected prompt to save the merge results. Once accepted, another prompt is
displayed to save a temporary document. You can safely answer "No" to that prompt.

Using ClearCase with Sybase PowerBuilder

Using the ClearCase integration with PowerBuilder requires some configuration steps.
In addition, there are some differences between the integration with PowerBuilder 6.x
and PowerBuilder 7.x.

Applying Patches to PowerBuilder 7.x

Before using the ClearCase integration with PowerBuilder 7.0 to
7.02, apply the latest PowerBuilder patch available for the file PB-
SCC70.DLL. You can download this patch from the Sybase FTP site at
ftp://psaftp.sybase.com/pub/private/pbpatch/pb701.weekly/202861.zip. This patch is not
needed for PowerBuilder versions later than 7.02.

Enhancing the ClearCase-PowerBuilder Integration

Use the following procedure to add a Help button to the ClearCase integration with
PowerBuilder. After the integration is configured, PowerBuilder displays an icon on
its toolbar for ClearCase Help.

1 Start PowerBuilder

2 Right-click the Powerbar (where the icons are located); on the menu, click Customize.

3 Select your icon by clicking the Custom option.

4 Select an icon, drag it to the Powerbar, and position it as desired relative to the
other icons on the bar.

5 To separate the ClearCase Help button from others on the Powerbar, use one or more
separator icons (located in the left corner of the set of possible icons).

6 After the new icon is positioned, you are prompted to enter the command line to
be associated with the icon, as well as text to represent the icon in the Microhelp
and when the cursor is positioned over the icon. Set the command line to the
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value winhlp32.exe ccase-home-dir\bin\ph_int.hlp. Set the values of the Item Text and
Item Microhelp boxes to ClearCase Help.

7 Click OK to finish the configuration.

ClearCase Integration Differences: Version 6.x and 7.x

New PowerBuilder 7.x functionality is reflected in the following differences between
the ClearCase integrations with PowerBuilder 6.x and with 7.x.

In 7.x, the Source menu includes the command Add Objects.

In 7.x, there is no Source>Create New Release command; that functionality is
provided by Library>Create.

In 7.x, if your VOB is set up for UCM development, when you click
Source>Configuration to open the Configuration dialog box, and then click Advanced,
ClearCase displays an Activity option

Error5 Message When Using PowerBuilder Integration

If you select an object from the public directory and click Source>Register, the
integration opens a dialog box where you enter the name of the .PBL library. If the
library you specify does not exist in the archive directory, the integration creates a
new one and adds it to source control in the archive directory. If you attempt to check
out the same object from the public directory by clicking Source>Check Outspecifying
a different name, the integration fails with an error5 message. To work around
this problem, be sure to enter the exact name of the target .PBL when you check out
an object.

Error Opening config_spec During View Startup

At view startup, more than one process may need to access the view’s configuration
files. Prior to Release 4.2, the sharing mode used to open these files was too restrictive,
resulting in occasional failures when trying to access these files. At this version of
ClearCase, the sharing mode allows all processes to be granted the access they require.

Problems When Administrative VOBs Are Unavailable

An administrative VOB is used by one or more other VOBs as a central repository of
global type objects. For a description of this feature, see the Administrator’s Guide .

ClearCase users may see errors when the administrative VOB is unavailable.
Following are examples of situations when this may happen:
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A user attempts to attach a version label, using a label type that was previously
created automatically, as a local copy of a global label type. The ClearCase mklabel
command tries to contact the administrative VOB that contains the global label
type. If that administrative VOB is unavailable, the mklabel command fails.

A VOB backup script attempts to lock the entire VOB object of vobsprojproj\\\
before copying data to tape. For each administrative VOB used by vobsprojproj\\\,
the ClearCase lock command tries to contact the administrative VOB. If any
administrative VOB is unavailable, the lock command fails, which causes the
backup script to fail.

To disable the above checking for a particular ClearCase command (for example, to
keep working while an administrative VOB is offline):

1 Log on as administrator.

2 Set the environment variable CG_PROCFLAGS to the value no_process.

a Open the System Control Panel.

b Click the Environment tab.

c Set the user variable CG_PROCFLAGS to the value no_process.

3 Execute the command.

Restrictions on Use of VOB Schema 53 with Domain Trust Lists

This note applies only to VOBs using the VOB schema 53, not to VOBs formatted
using the schema (54) provided originally with Release 4.0.

You can change the contents of a domain’s trust list with the User Manager for
Domains, but the contents of a domain’s trust list rarely change. Because of the way
ClearCase implements security, removing domains from a domain’s trust list can
invalidate ClearCase security information. Restoring a removed domain to a trust list
does not fix ClearCase’s security data.

More specifically, if the domain you remove from a trust list contains ClearCase user
accounts or computers that use ClearCase, then ClearCase protection errors may
result. Symptoms of these errors are as follows:

Certain operations, such as checkout, may fail.

ClearCase may print numeric values when you expect user names.

To display user and group information, use the creds command.

Because of these potential problems, we recommend that you avoid removing
domains from a domain’s trust list. If a domain is removed from a trust list, contact
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Rational Technical Support for information on how to correct ClearCase’s security
information.

Restrictions on Use of VOB Schema 54

There are a number of restrictions on the use of the larger VOBs created using the
extended VOB functionality (VOB schema 54):

reformatvob –rm may not completely remove an old VOB database directory
during the load phase of the reformat operation. If the reformat cannot be
completed because there is not enough disk space on the host, remove the
old VOB database directory manually. This directory has a name of the form
VOB-storage-directorydb.reformat\. After you remove this directory, run reformatvob

–load.

reformatvob uses the space command to calculate the amount of space needed for
a reformatting operation. This fails for large database files, although the failure
does not cause the reformat itself to fail.

The space command cannot successfully run the stat() routine on large database
files. As a result, the cleartool space –vob –generate command can fail. This, in
turn, can cause the Standard ClearCase Daily Tasks task, supported as part of new
administration functionality in Release 4.0, to fail. If you have a VOB with large
database files, the space command fails nightly on scheduled jobs.

To avoid this problem, edit the scheduled job list so that it runs only on VOBs that
do not have large database files. You can do this by modifying the Daily Vob Space
task on the MMC console Properties sheet.

ClearCase Client/Server Requirement for Creating Storage
Directories

ClearCase client systems can only create view or VOB storage directories on a
ClearCase server system running the same release of ClearCase. For example, a
ClearCase client system running Version 2002.05.00 cannot create a view or a VOB
storage directory on a system running Release 4.x.

Do Not Change VOB/View Storage Directory ACLs on NTFS
File Systems

On NTFS partitions, each ClearCase VOB or view storage directory has an access
control list (ACL). Modifying the ACL in any way can render the VOB or view
unusable.
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Because the standard Windows NT file-copying tools (and some backup utilities) do
not preserve file and directory ACLs, use the procedures in the Administrator’s Guide
to copy, move, or restore a VOB or view storage directory.

NFS Client Issues

The following sections describe issues with various NFS clients.

Some Commands Need NFS or SMB Access to VOB Storage Directories

The following commands require NFS or SMB access to the VOB storage directory
when it resides on a UNIX host:

lsvob –storage

mkpool

mktag

register

rename (pools)

unregister

Do Not Enable Automatic Mounting of NFS Directories

In NFS products with UNC support, do not enable automatic mounting of
NFS-storage directories. If you enable automatic mounting, you may experience
problems starting views and VOBs located on UNIX hosts.

Restart After Changing ClearCase Registry Server

Some ClearCase operations may not work correctly after you change your default
registry server. Some symptoms include ClearCase shortcut menus that do not
appear correctly or source control operations that fail in Microsoft Visual Studio.
We recommend that you shut down and restart your computer after changing the
registry server.

Dynamic Views Do Not Support Microsoft Access Databases

Because dynamic views do not support DOS sharing modes, do not use a Microsoft
Access database from a dynamic view.

Microsoft Access uses a lock file (identified by the .ldb extension) to arbitrate access to
the database. When a client accesses the database to read or to write, it creates the .ldb
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file. When a client stops accessing the database, it attempts to delete the .ldb file. In a
file system that supports DOS sharing modes, such as a native Windows file system, if
other clients are accessing the database, the .ldb file cannot be deleted.

In a dynamic view (which uses the MVFS, or multiversion file system), the .ldb file
can be deleted by any client, so that the next client to open the database creates
and uses a new .ldb file, which exposes the database to multiple writes to the same
records. For more information on the MVFS and its known limitations, refer to the
Administrator’s Guide for Rational ClearCase.

Workaround: Use Microsoft Access databases only from snapshot views located in a
file system that supports DOS share modes (such as a native Windows file system).

No Built-in Support for Shipping Server-Only Installation

The installation procedure on Windows NT for ClearCase does not automate
a MultiSite shipping server-only installation. For more information on how to
accomplish this, contact Rational Technical Support.

Creating VOBs and Views on Windows 2000 Hosts

On Windows 2000 hosts, VOBs and dynamic views must be created with the storage
directory on a partition that has a drive letter assigned. If the VOB or view storage is
on a Windows 2000 mounted drive, local clients cannot access the VOB or view.

DDTS Integration Uses Wrong Environment Variable

The DDTS trigger scripts use the CLEARCASE_PNAME environment variable, but this
environment variable is not set. Instead, the CLEARCASE_PN environment variable is
set to the correct value.

The workaround is to set CLEARCASE_PNAME to CLEARCASE_PN at the beginning of
each trigger that uses the environment variable.

ClearCase Details Replaced by ClearCase Explorer

The ClearCase Details tool was replaced by ClearCase Explorer in Release 4.1. It is no
longer available in this release of ClearCase,
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reformatview May Fail Under Certain Conditions

On Windows systems, automatic view reformatting may be unable to move the
view’s database directory, "db", to an alternate name during the dump phase if the
file is open or if a process has a current working directory there. The view server will
retry the rename operation two times at 60 second intervals to allow any processes to
close the directory or set working directory elsewhere. In case the retries fail, ensure
there are no open files in the view’s database directory and attempt to access the view
again. It should reformat cleanly. All of these operations are logged in the view log.

Documentation Issues

This section presents late changes to documentation and describes errors or
information missing from the documentation delivered with ClearCase software.

Problem with Reference Pages

The following problem relevant to ClearCase exists in the Command Reference.

mount

On Windows NT, mounting VOBs with the read-only option (ro) has no effect.

rebase

With the introduction of stream hierarchies at this release, most of the rules for
rebasing an integration stream and a development stream are now the same. The
rebase reference page contains sections on Rules for Development Streams and Rules
for Integration Streams. These sections are superseded by information in the section
Rebasing a Stream on page 54 in this version of the release notes.

Problem with Developing Software Manual

The Developing Software manual for ClearCase is missing information relating to the
following topics.

Cannot Run ClearCase Commands in a UNIX Snapshot View From
a Windows Client

You can access a snapshot view that was created on a UNIX host from a Windows
ClearCase client, but you cannot run ClearCase commands from that Windows client
and have them be effective in the UNIX snapshot view. For example, if you use
Windows Explorer to navigate to a team member’s view on a different computer and
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right-click a file in the view, ClearCase options may not be available. To perform
ClearCase operations on the files in a team member’s view, register the view as
follows:

1 In Windows Explorer, navigate to the root directory of the view you want to
register.

2 Right-click the root directory of the view.

When you right-click the root directory of the view, ClearCase registers the view by
adding an entry to your Windows User Profile.

Delivering Work From a Snapshot View

If you deliver your work to a snapshot view, you can encounter an error caused by
your not having ever registered the snapshot view. This condition occurs because
ClearCase cannot find the path to the snapshot view root directory until you register
the view. Typically a view is registered when you run the mkview command.

On Windows computers, you see the following messages:

The deliver operation is unable to access the root of the
’%s’ snapshot view.
(Before trying again, make sure that you can access
ClearCase properties by right-clicking on the view’s root
directory in the Windows explorer.)

Performing the recommended action registers the snapshot view so that the deliver
can proceed.

Handling Elements That Are Not Visible

(The following material should be used as part of Section 5.4, Merging Versions in
Part 2, Working in UCM.)

During a deliver (or rebase) operation, you can see the following warning message
about elements not being visible in the integration view:

1 elements were skipped because they are not visible. You should
determine why they are not visible before you complete this deliver
or rebase operation. If these elements should be visible, cancel
this operation, fix the problem, and re-run the operation.

Do not ignore this situation. The deliver operationfound versions of elements in the
development stream that need to be considered for merging to the target stream,
but did not find the elements in the target stream. Some possible causes for this
situation are:

A new element was added to source control, but the directory that catalogs the
element is not checked in.
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In this case, cancel the deliver or rebase operation, check in the directory, and
start deliver or rebase again.

While a change to the element was being made (in the development stream, for
a deliver; in the stream from which you are rebasing, for a rebase), someone
operated on the element (in the target stream, for a deliver; in the development
stream, for a rebase), as follows:

The name of the element or the name of a VOB symbolic link to the element
was removed.

The element itself or the VOB symbolic link to the element was removed.

In either case, decide whether the removal was appropriate. If the removal was
appropriate, you can allow the deliver or rebase to ignore the element.

The change may be obsolete, because you intended to remove the name of the
element or the element itself.

Because ClearCase cannot tell what caused the situation, you must find the cause, fix
the problem, cancel the current operation, and start over.

Problems with Administrator’s Guide

Because of a change in the scaling algorithm, Table 13 on page 507 of the
Administrator’s Guide for Rational ClearCase shows incorrect values for the effect of
memory size on the MVFS Scaling Factor for memory sizes greater than 256 MB.
The corrected values are:

Memory Size MVFS Scaling Factor

<24MB 0

24MB-511MB 1

512MB-2.99GB 2

>=3GB Memory Size (in GB)

The largest value that the Scaling Factor is automatically set to is 24.

Problems with Online Help

The following issues exist with online help.

Topic Not Found

If you start help by pressing F1 in an application window (context-sensitive help) and
begin a series of jumps into the online documentation, you may see the error help
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topic not found, when in fact the topic exists. If you click OK in the error message
box, the topic then appears.

PowerBuilder Integration Help

In the Configuring the PowerBuilder/ClearCase integration for UCM use (new PBLs)
module of the PowerBuilder Integration Help, the perl command in step 2b should
read

ccperl ccase-home-dir/bin/ccpb_ucm_config.pl

Help Window is Blank

Occasionally, a ClearCase help topic fails to appear: the title appears, but the body of
the window is blank. When this happens, you can correct the problem as follows:

1 In the Help window menu bar, click Options>Font>Normal. The Help window
is refreshed.

2 If the wrong help topic is displayed when the help window is refreshed, click the
Back button to return to the original topic.

Issues with Tutorials

This section describes problems with running tutorials.

Problems with Line Endings in Makefiles

The Base ClearCase Dynamic Views tutorial uses scripts that create a tutorial
environment and populate it with files that allow the user to learn in an interactive
manner how to work with ClearCase. One of these files is a file called Makefile, which
is used when the user is instructed to build the tutorial application. When each line
of this file ends in ^M it prevents the user from building the tutorial application. To
resolve this issue, check out the Makefile, remove the ^M characters at the end of
each line, and then check the file back in.

Tutorials in Windows Environment

Before users run the tutorials, the administrator must set the correct view and VOB
storage needed to run the Windows NTor Windows 2000 tutorials. Users can verify
that this was done by entering the following cleartool lsstorage commands and
checking the output:

cleartool lsstorage –view

cleartool lsstorage –vob
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If each command does not display a list of views or VOB storage locations, the tutorial
will not run.

Tutorial Setup Script Fails on Windows XP

In Task #6 of the ClearCase UCM Project Manager tutorial, a setup script prepares the
tutorial environment to allow the user to create a new baseline. When executing the
setup on a system running Microsoft XP, the setup script fails to execute correctly.

The workaround is to set the COPYCMD environment variable with a value of /Y as
follows:

1 Open the Control Panel and click the System icon.

2 Click the Advanced tab and then click Environment Variables

3 Under User variables click New.

4 As Variable Name, enter: COPYCMD

5 As Variable Value, enter: /Y

6 Click OK to close the New User Variable dialog box, the Environment Variables
dialog box, and then the System Properties dialog box.

You can then resume the tutorial.

Tutorials in a Mixed Environment

The ClearCase tutorials cannot be run on Windows client hosts that use UNIX servers.
VOB creation is not supported across heterogeneous network configurations, and all
ClearCase tutorials create private VOBs.
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Restrictions and
Guidelines for
MultiSite

5

This chapter contains release notes for Rational ClearCase MultiSite Version
2002.05.00.

disprun Utility Has Been Removed From This Release

The at-based mechanism (the disprun utility) for scheduling MultiSite jobs has been
removed from this release. For more information on scheduling synchronization with
the ClearCase scheduler, see the schedule reference page and the Administrator’s
Guide for Rational ClearCase MultiSite.

Magnetic Tape Option No Longer Supported

In this release, support for the –tape option in mkreplica and syncreplica has been
removed.

Change to Name of Lock File Used by Scripts

In previous releases, the name of the lock file created by the sync_export_list and
sync_receive scripts may not be unique because the name was based on the replica
name. In this release, the name of the lock file is based on the UUID of the replica,
not on the replica name.

Change to Unreserved, Nonmastered User Preference

If you select the Unreserved, nonmastered if branch is mastered by another replica check
box in the ClearCase User Options dialog box, the setting is ignored when you check
out an element in a UCM view.
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Change in Display of Packet Expiration Value

In the MultiSite Control Panel, if you select the Use Default Expiration check box for a
storage class, the value displayed in the Packet Expiration box is -1. To display the
actual value, display the -default class. If you clear the Use Default Expiration check box,
you must change the Packet Expiration value to a number equal to or greater than 0.
Otherwise, the Use Default Expiration check box is selected when you click OK.

Warning on Receipt of Packet from Earlier MultiSite Version

Table 14 lists the packet protocols for MultiSite versions.

Table 14 MultiSite Versions and Packet Protocols

MultiSite version Packet protocol

3.2, 3.2.1 1.2

4.0, 4.1, 4.1.1, 4.2 3

2002.05.00 4

When multitool with a newer protocol reads a packet with the older protocol, it prints
this message:

multitool: Warning: Version mismatch, software:new-protocol, packet:old-protocol

This message does not indicate a problem. It means one of the following things:

The feature level of the VOB family is lower than the feature level of the receiving
replica.

The feature level of the VOB family is the same as the feature level of the sending
and receiving replicas. However, when the sending replica created the update
packet, it had not yet received a packet containing the information about the new
VOB family feature level.

Synchronization Error When Database Limit Is Exceeded

ClearCase Releases 4.x include support for a new VOB database schema. If you update
one or more replicated VOBs in a family to the new schema (version 54), you do not
have to update the other replicas in the VOB family immediately. However, you must
update all replicas before one of the updated replicas exceeds the database limit of the
previous schema (version 53). If you do not, replicas that have not been updated will
not be able to import synchronization update packets from the updated replica.
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When this type of import failure occurs, syncreplica output includes a VOB database
error, and an error is written to the db log.

The syncreplica output includes an error like the following:

multitool: Error: Error from VOB database: ’’\\vob.setup’’.

The db log includes an error like the following:

09/20/96 10:40:49 db_server(19528): Error: DBMS error in "../db__lock.c" line 79
*** db_VISTA database error -909 - file record limit exceeded
09/20/96 10:40:49 db_server(19528): Error: DBMS error
09/20/96 10:40:49 db_server(19528): Error: db_VISTA error -909

To fix this problem, you must convert all replicas in the family to schema version 54.
To display the schema version for a VOB replica, use the cleartool describe vob:vob-tag
command. To display the schema version of the ClearCase release installed on your
computer, use the cleartool –ver command.

Limitation on Editing Mastership Request ACL

In this release, you do not have to be logged on to a VOB server host to edit the
mastership request ACL for a replica on that host. However, if you are not already
on the ACL, both of the following conditions must be true in order for you to edit
the ACL:

You must be the VOB owner or privileged user.

You must be logged on to a host in the same domain as the VOB server host.

Handling Pathnames That Contain Spaces

If the pathname of a receipt handler or a shipping order contains spaces, DOS “short
name” resolution must be enabled for the file system on which the receipt handler
or shipping order is located. This property is enabled by default. If this property is
not enabled, the shipping_server cannot invoke the receipt handler or process the
shipping order.

Do Not Use MultiSite to Clone a VOB

Do not use MultiSite to create multiple copies of a VOB in a single ClearCase region.
Because the VOB UUID is identical for all replicas in a VOB family, and is stored in
many structures within a VOB, there is no way to make the copy of the VOB unique.
Creating and using multiple copies of a VOB in a single region causes clearmake and
views to exhibit unpredictable behavior, may cause data loss, and is not supported by
Rational Software.
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Using UCM and MultiSite

The following restrictions apply to use of UCM and MultiSite:

You cannot request mastership of branches or branch types that are associated
with streams.

If a UCM component is replicated, its associated UCM project VOB (PVOB) must
be replicated.

You must synchronize a UCM component and its associated PVOB at the same
time.

UCM projects enabled for ClearQuest can be replicated and synchronized. In
addition to using ClearCase MultiSite to replicate and synchronize UCM project
and component VOBs, you can use Rational ClearQuest MultiSite to replicate and
synchronize associated ClearQuest user databases. You must synchronize a UCM
PVOB and its associated ClearQuest user database at the same time.

MultiSite Support on Windows Platforms

MultiSite runs on the Windows NT and Windows 2000 platforms. The ClearCase
MultiSite Manualuses the term “Windows” to refer to these platforms.

Note: Replicated VOBs on a Windows server can be accessed from any ClearCase
client host running Windows and from UNIX snapshot views.

Problems with Documentation

The epoch_watchdog reference page has an EXAMPLES heading but does not contain
any examples. For an example of using epoch_watchdog, see Troubleshooting MultiSite
Operations in the Administrator ’s Guide for Rational ClearCase MultiSite.

In the reqmaster reference page, the output for reqmaster -deny for a branch type is
incorrect. The correct output does not include the words "branch type".

On page 151 of the Administrator’s Guide for Rational ClearCase MultiSite, the output
for the command cleartool describe -fmt "%[reqmaster]p\n" brtype:boston_main@/vobs/dev
is incorrect. The corrected example:

cleartool describe -fmt "%[reqmaster]p\n" brtype:boston_main@/vobs/dev
denied for branch type
denied for all instances
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Status of ClearCase
Software Change
Requests

6

Noteworthy problems found in or resolved in Version 2002.05.00 of Rational
ClearCase are listed in the file cc_issues.htm.

You can find this file in two places:

On your ClearCase CD, in the folder Rational\doc\platform, where platform is
an architecture mnemonic like ux (for UNIX computers) or nt (for Windows
computers).

In the folder ccase-home-dir\install\ after you’ve installed the product.

Note that any problems relating to installation or setup of ClearCase are noted in the
section Known Issues Related to Installation on page 14.
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Status of MultiSite
Software Change
Requests

7

Noteworthy problems found in or resolved in Version 2002.05.00 of Rational
ClearCase MultiSite are listed in the file ms_issues.html.

You can find this file:

On your ClearCase CD, in the folder Rational\doc\platform, where platform is
an architecture mnemonic like ux (for UNIX computers) or nt (for Windows
computers).

In the folder ccase-home-dir\install\ after you’ve installed the product.

Note that any problems relating to installation or setup of MultiSite are noted in the
section Known Issues Related to Installation on page 14.
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Network Attached
Storage Devices
Certified For Use
With ClearCase

A

Network-attached storage (NAS) devices communicate with other hosts on a local
area network using a network file system protocol like the Network File System (NFS)
or the Common Internet File System (CIFS). While any NAS device can provide
storage for ordinary files that are created and used by ClearCase, only the NAS
devices described in this section have been certified for use with VOB server and view
server hosts. When configured and used as described in this section, these devices can
provide remote storage for VOB and view databases in addition to ordinary files.

Caution: Every certified NAS device must be specially configured to support
remote VOB or view databases. If you do not configure a certified NAS
device as described, you put your VOB or view data at risk. If you host a
VOB or view database on a NAS device that has not been certified for this
purpose, you will put your VOB or view data at risk.

The Administrator’s Guide has more information about putting VOB or view databases
on certified NAS devices.

Supported Platforms and Protocols

Rational has certified the following NAS devices for the uses described in
Administering ClearCase. Not all NAS devices can support VOB or view servers
on Windows hosts.

Table 15 Supported NAS Devices

Vendor Product Software Version

VOB or view
server platforms
supported

Auspex NS2000 NetOS 3.0.1 UNIX only
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Vendor Product Software Version

VOB or view
server platforms
supported

EMC Celerra File Server 2.2 (contact EMC
Customer Service
for ClearCase
patch)

UNIX and
Windows

Network
Appliance

Series 7xx Filer,
Series 8xx Filer

DataOnTAP
OS V5.3.6,
DataOnTAP OS
V6.0.1

UNIX and
Windows

Note: Rational only supports use of the NFS protocol to connect a UNIX VOB
server host with a VOB database on a NAS device. You must use the CIFS protocol
to connect with NAS devices from Windows hosts. Use of NFS software to connect
Windows hosts to NAS devices is not supported by Rational.

All of the NAS devices described in this document can be configured to support
native interoperation with both UNIX and Windows hosts. You do not need to install
a third-party NFS product on Windows or an SMB server product on UNIX to make
VOBs and views on NAS devices accessible to both UNIX and Windows hosts.

The following sections describe procedures for configuring and using various NAS
devices with ClearCase. In these sections, we assume that:

you are familiar with the basic configuration and operation the NAS device you
are using

you have already installed the device on your network and verified that it can be
used with applications other than ClearCase

We also assume that you have established the appropriate level of cross-platform
interoperability for your site if both UNIX and Windows computers are in use as
ClearCase hosts. All the requirements detailed in the Administrator’s Guide for user
and group accounts on both UNIX and Windows must be met if you are using a NAS
device to host ClearCase data that is accessed from UNIX and Windows computers.
NAS devices often provide their own implementation of cross-platform file-access
solutions such as NFS and CIFS (SMB), but these implementations usually require that
any user who must access files on the NAS device can be authenticated using the same
user name and group name regardless the type of platform (UNIX or Windows) they
are using. If ClearCase users at your site use UNIX and Windows computers, verify
that users can create and delete file and directories on the NAS device from both UNIX
and Windows before proceeding with additional NAS device configuration steps.
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Caution: Rational does not support use of CIFS oplocks on any NAS device used
for VOB or view storage. By enabling oplocks on such a NAS device, you
put any ClearCase data on that device at risk. Instructions for disabling
oplocks on each certified NAS device are included in this chapter.

Auspex NS2000

This section describes configuration procedures that you must perform before you
can use an Auspex NS2000 NAS device for VOB or view storage as described
in Administering ClearCase. For additional information about the NS2000, see
www.auspex.com.

Data stored on an Auspex NS2000 can be organized into virtual file systems and
shares on virtual partitions and RAID sets. A RAID set may be "sliced" into
independent file systems using virtual partitions. A RAID set must contain at least
three data disks. Auspex recommends a RAID set with at least six data disks for
frequently accessed ClearCase data.

Configuring the Auspex NS2000 for ClearCase

These are the steps you must take to configure the Auspex NS2000 for use by
ClearCase.

1 Create a filesystem if necessary. You may use an existing file system or create a
new one specifically for use by ClearCase.

2 Create partitions. For ease of administration, Auspex recommends using virtual
partitions on the NS2000 to hold ClearCase data. The remaining steps in this
section assume you are using a virtual partition named /dev/axvp/fspNvpX where N
is the number of the file system partition and X is the virtual partition number:

3 Create a file system mountpoint. Log in to the NS2000 as root. Run the following
command to create a mountpoint for the virtual filesystem you created in Step #2:

mkdir /vobstg

4 Mount the virtual file system. Run the following command to mount the virtual
file system you created in Step #2 at the mountpoint you created in Step #3:

mount -F lfs /dev/axvp/fspNvpX /vobstg

To ensure that a virtual file system is mounted at boot time, create an entry for it
in /usr/AXbase/etc/lfstab.

5 Enable read/write access for the albd_server. All volumes used for VOB or view
storage must be configured with read/write (rw) access by the ClearCase server
process user account (Windows) and root (UNIX).
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6 Make the file system accessible. Volumes that will only be accessed by UNIX
computers must be shared using the NetOS share command. Volumes that will
only be accessed by Windows computers must be shared using the NetOS net share
command. Volumes that must be accessed by both UNIX and Windows computers
must be made accessible using both commands. The following command makes
the file system mounted at /vobstg accessible to NFS clients:

share -F NFS /vobstg

7 Disable oplocks. Opportunistic locking (CIFS oplocks) is enabled by default on
the NS2000. You must disable oplocks by setting the NS2000 registry key:

HKLM\SYSTEM\CurrentControlSet\Services\AdvancedServer\FileServiceParame-

ters\UseOplocks

to a value of 0 using the NetOS regconfig command or the Windows regedt32
command. To use regedt32 to edit the registry on the NS2000, click

Registry>Select Computer

and type the name of the NS2000 in the Select Computer dialog box.

Using NS2000 Snapshot Backups

The Auspex NS2000 snapshot backup tool ax_snapshot allows you to quickly make a
read-only copy of a virtual file system. We support use of ax_snapshot to make backups
of all ClearCase data, including VOB data. The following command line creates a
snapshot on cache partition fsp1m0rd1s0 of a virtual partition mounted at /vobstg:

ax_snapshot ckpt /vobstg fsp1m0rd1s0

As with any VOB backup strategy, you must lock the VOB before backing it up.
Because the snapshot backup copy can be made quickly, lock time required for the
backup will be minimal.

A cached snapshot backup should also be backed up to hard media such as tape or
CD, using backup software (for example, the Auspex utility ax_gtar) that will preserve
all file system information, including ACLs if the file system is used to hold VOBs
or views served by a VOB or view server on Windows.

Note: To back up a cached snapshot, you must first mount it.

By default, NS2000 file-based backup does not back up files larger than 2GB. VOBs
using schema version 54 may include some files larger than 2GB. To ensure that these
files are included in hard-media (file-based) backups of a snapshot cache, edit the file
/usr/AXndmp/etc/config on the NS2000 as follows:

1 Locate the following line:
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#ALLOW_TAR_EXTENSION # auspex extension to support large files (>=2GB)

2 Remove the first comment delimiter (#) to enable this feature.

ALLOW_TAR_EXTENSION # auspex extension to support large files (>=2GB)

Note: When this option is enabled and a large file is encountered during file-based
backup, Auspex’s proprietary extension to standard GNU-tar format is used instead
of the standard GNU-tar format. With this option on, you may not be able to use the
standard GNU-tar command to recover data from file-based backups

EMC Celerra File Server

This section describes configuration procedures that you must perform before you can
use an EMC Celerra File Server for VOB or view storage as described in Administering
ClearCase. For additional information about the Celerra File Server, see www.emc.com.

Configuring a Celerra File Server for ClearCase

These are the steps you must take to configure a Celerra File Server for use by
ClearCase.

1 Configure storage. Create an appropriate network interface, metavolume, and file
system for use by ClearCase.

2 Create a mountpoint for the filesystem you created in Step #1.

3 Mount the file system. Use the -o nooplock option to server_mount to disable CIFS
oplocks. The default access checking policy for server_mount is NATIVE. We
recommend that you use this default.

4 Export the file system as needed for UNIX (NFS) and/or Windows (CIFS) clients.
The following commands export the file system /ufssc1 on Data Mover server_2 for
NFS and CIFS access.

server_export server_2 /ufssc1
server_export server_2 -P cifs -n ufssc1

/ufssc1

Note: You must also configure and start CIFS services if you are exporting a file
system for CIFS access.

Using Celerra TimeFinder and SnapSure Backups

The EMC Celerra TimeFinder facility creates a mirrored copy of a file system on the
Celerra device. The SnapSure facility creates a read-only copy of a Celerra file system
on another volume on the device. We support use of either facility to make backups of
all ClearCase data, including VOB data.
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As with any VOB backup strategy, you must lock the VOB before backing it up.
Because these copies can be made quickly, lock time required for the backup will be
minimal.

Network Appliance Filer

This section describes configuration procedures that you must perform before you
can use a Network Appliance Filer for VOB or view storage as described in the
Administrator’s Guide. For additional information about Network Appliance Filers,
see www.netapp.com.

Data on a Network Appliance filer is organized in volumes. A volume is an
independent file system with its own RAID group(s). Every RAID group must contain
at least two disks (the default is 8). Network Applicance recommends creating
volumes with at least four data disks if they contain frequently accessed ClearCase
data. Smaller volumes may be adequate for storage pools containing infrequently
accessed or read-only data.

In addition to creating volumes to hold ClearCase data on a Network Appliance Filer,
you must also create qtrees to manage access control for the files and directories in
these volumes, and you must use the appropriate commands to make these volumes
accessible to UNIX and/or Windows clients.

Configuring a Network Appliance Filer for ClearCase

These are the steps you must take to configure a Network Appliance Filer for use
by ClearCase.

1 Create volumes. Create one or more volumes on the Filer for use by ClearCase.
You must use the nvfail on option to the Data ONTAP vol command. The following
commands create a volume named ccvol that uses 10 disks.

vol create ccvol 10
vol options ccvol nvfail on

Note: Network Appliance Filers provide a specialized snapshot backup facility (not
related to the ClearCase snapshot backup program), which is managed at the
volume level. Keep backup considerations in mind when allocating volumes
to hold VOB data or other ClearCase data. It will simplify implementation of
Network Appliance snapshot VOB backups if you dedicate one or more volumes
exclusively to VOB storage.

2 Disable quotas on volumes to be used for VOB storage. If quotas are enabled,
Network Appliance recommends disabling them on volumes used for VOB
storage. The following Data ONTAP command reports on whether the volume
ccvol has quotas enabled:
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quota report ccvol

The following Data ONTAP command disables quotas on the volume ccvol:

quota off ccvol

3 Make the volume(s) accessible. Volumes that will only be accessed by UNIX
computers must be exported using the Data ONTAP exportfs command. Volumes
that will only be accessed by Windows computers must be shared using the
Data ONTAP cifs_shares command. Volumes that must be accessed by both UNIX
and Windows computers must be exported and shared.

4 Enable read/write access for the albd_server. All volumes used for VOB or view
storage must be configured with read/write (rw) access by the ClearCase server
process user account (windows)and root (UNIX).

5 Create qtrees. A qtree is a special subdirectory of the root directory of a volume.
The following Data ONTAP command creates a qtree named vobstg in a volume
named ccvol.

qtree create /vol/ccvol/vobstg

6 Specify each qtree’s security style. The Data ONTAP qtree command allows you
to specify the type of access checking (security style) that will be used when a
determining whether a user has rights to access a file or directory. You can specify
any of three security styles:

unix evaluates user access rights by considering the UID and GID of the user
and the access mode of the file or directory

ntfs evaluates user access rights by considering the SID of the user and the
ACL of the file or directory

mixed provides support for both security styles

The following Data ONTAP command specifies that the unix security style will be
implemented in the qtree named vobstg

qtree security vobstg unix

Note: For any qtree used to provide VOB storage server by a VOB server running
Windows, you must set the qtree security style to ntfs.

7 Disable oplocks. Opportunistic locking (CIFS oplocks) is enabled by default when
a qtree is created. The following Data ONTAP command disables oplocks on
the qtree named vobstg:

qtree oplocks vobstg disable
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Using Network Appliance Snapshot Backups

The Network Appliance snapshot backup facility creates a read-only copy of a volume
on another volume on the Filer. We support use of this facility to make backups of
all ClearCase data, including VOB data.

As with any VOB backup strategy, you must lock the VOB before backing it up.
Because the snapshot backup copy can be made quickly, lock time required for the
backup will be minimal.
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